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Welcome

 

Thank you for purchasing the BJC-2100 Series Color Bubble Jet Printer.

 

Printer Documentation

 

The documentation for your printer consists of these items:

 

� 

 

Quick Start Guide

 

Shows you how to set up the printer and prepare it for operation according to your computer 
system. You may also need your computer manual for reference during setup.

 

� 

 

User’s Manual (this manual)

 

Shows you everything you need to know about using the printer efficiently and safely. A 
detailed troubleshooting section provides step-by-step guidance for identifying and solving 
printing problems.

This 

 

User’s Manual

 

 provides complete explanations of the features and functions of the 
printer. To maximize the life of your printer, it’s a good idea to familiarize yourself fully with 
all of its functions.
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Printer Documentation

 

� 

 

Conventions

 

This 

 

User’s Manual

 

 uses the following symbols to indicate important information. Always 
observe the instructions indicated by these symbols.

Cautions alert you to ways to avoid injury to yourself, damage to the 
printer, or the loss of valuable data.

Notes provide advice, tips, and suggestions that are intended to help you 
work more efficiently with the printer.

This arrow and blue text indicate a link to where you can find more 
information about the current subject.

This manual uses the following symbols depending on the computer system you are using. 
Always observe the instructions indicated by these symbols.

Indicates information for Windows

 

®

 

 2000, Windows 98, Windows 95, and 
Windows NT users only.

Indicates information for iMac

 

TM

 

 and Power Macintosh

 

®

 

 G3 and G4 users 
only.

Throughout this guide the names Microsoft

 

®

 

 Windows

 

®

 

 2000, Microsoft Windows 98, 
Microsoft Windows 95, and Microsoft Windows NT 4.0, are abbreviated, respectively, as 
Windows 2000, Windows 98, Windows 95, and Windows NT.

Note

Caution

Windows

Macintosh
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How to Use This Manual

 

To view this 

 

User’s Manual

 

, please use Acrobat Reader 4.0, which is included on your 
CD-ROM, or a later version of Acrobat Reader.

Use this button when you wish to 
enlarge the screen you are viewing. 
Select this button in the tool bar, and 
then click within the screen of the 
User’s Manual. Use this button to display the 

next page of the User’s
Manual.

Use this button to 
return to the page 
you were viewing 
previously. This 
button moves you 
back from another 
page.

Use this button to display the 
previous page of the User’s 
Manual.
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How to Use This Manual

 

This column displays a table of contents for the 

 

User’s Manual

 

. 
Click the desired item to jump to the topic.
Click the + (or   ) symbol when you wish to see detailed headings for each chapter.
Click the – (or 

 

�

 

) symbol when you wish to return to the original (condensed) display.

Use this button 
when you wish to 
search for a word.

 

�

 

This arrow and blue text 
indicate a jump to another 
location in the 

 

User’s
Manual

 

 where the topic 
shaded in blue is 
discussed.
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Copyright

 

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) 
with all rights reserved. Under the copyright laws, this manual may not 
be reproduced in any form, in whole or part, without the prior written 
consent of CCSI.

© 2000 Canon Computer Systems, Inc.

 

Disclaimer

 

Canon Computer Systems, Inc. has reviewed this manual thoroughly in 
order to make it an easy to use guide for your Canon BJC-2100 Series 
Color Bubble Jet Printer. All statements, technical information, and 
recommendations in this guide and in any guides or related documents are 
believed reliable, but the accuracy and completeness thereof are not 
guaranteed or warranted, and they are not intended to be, nor should they 
be understood to be, representations or warranties concerning the 
products described.

Your printer and the software media included with your printer have been 
sold to you subject to the limited warranties set forth in the warranty card 
and license agreement enclosed with the respective products. All software 
is licensed AS IS, as described in the license agreement enclosed with the 
software media. Further, CCSI reserves the right to make changes in the 
specifications of the products described in this guide at any time without 
notice and without obligation to notify any person of such changes.
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Trademarks

 

Canon, BCI, BJ, and Bubble Jet are trademarks, and SelectExchange is a service mark of 
Canon Inc. Print Planet is a service mark of Canon Computer Systems, Inc.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the U.S. and 
other countries.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. All other product and brand names are trademarks or service marks of their 
respective owners.

E

 

NERGY

 

 S

 

TAR

 

®

 

 COMPLIANT

As an E

 

NERGY

 

 S

 

TAR

 

®

 

 Partner, Canon U.S.A., Inc. has determined that this product meets the 
E

 

NERGY

 

 S

 

TAR

 

®

 

 guidelines for energy efficiency.
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FCC Regulations

 

Color Bubble Jet Printer, Model BJC-2100

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.

Note: This equipment has been tested and found to comply with the limits for Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.
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FCC Regulations

 

FCC Regulations

 

Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of 
FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in 
the manual. If such changes or modifications should be made, you could be required to 
stop operation of the equipment.

 

Canadian Radio Interference Regulations

 

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus as set out in the interference-causing equipment standard entitled “Digital 
Apparatus,” ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux 
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: 
“Appareils Numériques,” NMB-003 édictée par l’Industrie et Sciences Canada.
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Safety Precautions

 

Please read the safety warnings provided in this manual to ensure that you use the printer 
safely. Do not attempt to use the printer in any way not described in this manual as this 
could result in unforeseen printer faults or cause a fire or electric shock.

Printer Location

Power Supply and Power Cord

Cleaning and Maintaining the Printer

Working Around the Printer

BJ

 

®

 

 Cartridges and Ink Tanks
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Safety Precautions

 

�  

 

Printer Location

 

Do not place the printer close to flammable solvents such as 
alcohol or thinners. If flammable solvents come in contact with 
electrical components inside the printer, such substances could 
cause a fire or electric shock.

Do not use flammable sprays near the printer. Gases in the spray 
could cause a fire or electric shock if they come in contact with 
electrical components inside the printer.

Do not install the printer in a location that is unstable or subject to 
excessive vibration. The printer could tip over or fall and cause 
injury.

Do not install the printer in locations that are very humid or dusty, 
in direct sunlight, or close to a heating appliance or fireplace. To 
avoid the risk of fires or electric shocks, install the printer in a 
location with an ambient temperature range of 41 to 95°F 
(5 to 35°C) and humidity of 10 to 90% (condensation free).
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Safety Precautions

 

Do not place the printer on a thick rug or carpet. Fibers or dust 
entering the printer could cause a fire.

Keep the power outlet for the printer free of all obstacles so you 
can unplug the power cord at any time. Such obstacles could 
prevent you from unplugging the printer when a printer fault occurs 
and cause a fire or electric shock.

When you are carrying the printer, always use both hands and hold 
the printer by both ends. When you are moving the printer to 
another location, keep it stable so that you do not drop it and cause 
injury.
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Safety Precautions

 

�  

 

Power Supply and Power Cord

 

The socket-outlet shall be installed near the equipment and shall be easily accessible.

Do not attempt to plug the power cord into the power outlet or 
unplug the power cord when your hands are wet. This could cause 
an electric shock.

Always push the plug all the way into the power outlet. A loose or 
poorly inserted plug could cause a fire or electric shock.

Do not damage, modify, stretch or excessively bend or twist the 
power cord. Do not place heavy objects on the power cord. Power 
leaking from a damaged power cord could cause a fire or electric 
shock.

Download from Www.Somanuals.com. All Manuals Search And Download.



 

18Introduction

Safety Precautions

 

Do not use the printer while the power cord is bundled or knotted. 
This could cause a fire or electric shock.

If you detect smoke, unusual smells or strange noises around the 
printer, immediately unplug the power cord. Continuing to use the 
printer in these circumstances could cause a fire or electric shock. 
Call the Canon Customer Care Center.

 

 Getting Help From Canon

 

Always grasp the plug when you unplug the power cord. 
Unplugging the power cord by pulling on the cord can damage the 
cord and cause a fire or electric shock.

Do not use a power supply voltage other than that supplied in the 
country of purchase. Using incorrect voltage could cause fire or 
electric shock. The correct power supply voltage and frequency is 
as follows:

USA/Canada: AC 120V, 60Hz
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Safety Precautions

 

�  

 

Cleaning and Maintaining the Printer

 

Use a damp cloth to clean the printer. Do not use flammable 
solvents such as alcohol, benzene or thinners. If flammable 
solvents come in contact with electrical components inside the 
printer, such substances could cause a fire or electric shock.

Always unplug the printer from the power outlet when you are 
cleaning the printer. If you mistakenly plug in the printer while 
cleaning it, you could touch moving internal printer components 
and suffer injury.

Do not attempt to disassemble or modify the printer. There are no 
user serviceable parts inside the printer. The printer contains high-
voltage components that could cause a fire or electric shock. Never 
attempt any maintenance procedure other than the ones described 
in this guide.
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Safety Precautions

 

�  

 

Working Around the Printer

 

Do not put your hands or fingers in the printer while it is printing. 
The printer contains moving parts that could cause injury.

Do not place metal objects (paper clips, staples, etc.) or containers 
of flammable solvents (alcohol, thinners, etc.) on top of the printer. 
Such objects could fall or spill into the printer and cause a fire or 
electric shock.

If any foreign object (metal or liquid) enters the printer, unplug the 
power cord and call the Canon Customer Care Center. Continued 
use of the printer when a foreign object has fallen into the printer 
could cause fire or electric shock.

 

 Getting Help From Canon
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Safety Precautions

 

�  

 

BJ

 

®

 

 Cartridges and Ink Tanks

 

For safety reasons store BJ cartridges and ink tanks out of the 
reach of small children. If a child inadvertently licks a BJ cartridge 
or ink tank or ingests any ink, consult a physician immediately.

Do not subject BJ cartridges or ink tanks to shocks or excessive 
vibration. This could cause the ink to leak out and stain your 
clothing or the surroundings.

Do not touch the metal contacts on a BJ cartridge after printing. 
The metal parts may be very hot and could cause burns.
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Basic Printing Procedures

 

Examining the Printer

Printing Your Document

Loading Plain Paper
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Examining the Printer

 

This section describes the parts of the printer and how they function.

 

�  

 

Front View

Paper Rest
Supports the media 
loaded in the auto sheet 
feeder.

Auto Sheet Feeder
Holds sheets of paper or other 
media for printing. The auto 
sheet feeder holds multiple 
sheets which are automatically 
fed into the printer one sheet at a 
time.

Front Cover
Open this cover to install or replace 
the BJ cartridge, change the paper 
thickness lever, or clear a paper 
jam.

Paper Guide
Align this guide with the 
edge of the sheet loaded 
into the auto sheet feeder.

Paper Output Tray
Holds the printed sheets when they 
are fed out of the printer. Fold this 
tray down before you start printing. 
It can be folded up while the printer 
is not in use.

RESUME Button
After you have resolved a sheet feeding problem, press 
this button to resume printing. You can also press this 
button twice to start a Nozzle Check Pattern.
You can start print head cleaning or reset the printer by 
pressing and holding down the RESUME button for 
more than two seconds. To avoid wasting ink, do not 
press and hold the RESUME button for more than two 
seconds unless necessary.
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Examining the Printer

 

To ensure optimum performance of the print head, the printer 
automatically cleans the print head every time it is plugged in or the front 
cover is closed after being open for more than a few seconds. Avoid 
unplugging the printer and opening the front cover unnecessarily as print 
head cleaning consumes ink.

 

�  

 

Back View

Note

Parallel Interface 
Connector
Connect the printer cable 
here and connect the 
other end of the printer 
cable to your computer.

Power Cord
Connect the power cord to the back 
of the printer then connect the other 
end to a power outlet. The printer 
switches on automatically after you 
connect the power cord. There is no 
power button or power light 
on the printer.

USB Interface
Provides a connection 
point for connecting a USB 
interface cable to the 
printer.
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Examining the Printer

 

�  

 

Inside the Printer

Cartridge Holder
Holds the BJ cartridge 
or the optional IS-22 
Color Image Scanner 
Cartridge.

Cartridge Lock Lever
Unlocks the cartridge 
holder so you can 
remove and replace the 
BJ cartridge. Raise the 
cartridge lock lever to 
release the BJ cartridge 
and lower it to lock the 
BJ cartridge.

Paper Thickness Lever
Adjust the gap between the 
print head and the paper. 
Set this lever for the type of 
media that you are using.

Download from Www.Somanuals.com. All Manuals Search And Download.



 

26Basic Printing Procedures

 

Printing Your Document

 

After you set up the printer, you can start printing. This section describes how to print a 
document on plain paper.

 

1

 

Create a document using an application program. (Or, open the file you
wish to print.)

Specify the paper size in the application program you are using.

 

2

 

Make sure that the printer is set up properly.

• Make sure that the printer is plugged in.

• Load a stack of plain paper into the auto sheet feeder.

Now you define settings in the printer driver dialog box.

 

 For Windows users

 For Macintosh users
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Printing Your Document

 

For Windows users

 

1

 

Open the Printer Properties dialog box.

Select the command used for printing, make sure the Canon BJC-2100 is 
selected as the default printer, and then click the Properties button. 
(Depending on the application program you use, the print operation 
procedure may be different. Refer to the documentation for your application 
program.)

Windows

   

Download from Www.Somanuals.com. All Manuals Search And Download.



 

28Basic Printing Procedures

Printing Your Document

 

2

 

Specify the necessary print settings in the printer driver. 

 

 Using the Windows Printer Driver

 

3

 

Click the OK button to close the Printer Properties dialog box.

Windows
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Printing Your Document

 

4

 

Start printing from the application program.

Click the OK button. Printing begins.

Windows

Click Here
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Printing Your Document

 

The following screen appears during printing.

 

BJ Backgrounder

 

The BJ Backgrounder is displayed in the lower right corner of the screen. 
You can cancel or pause the print job.

 

BJ Background Monitor 

 

The BJ Background Monitor is launched automatically and is minimized on 
the Windows Taskbar. You can cancel the print job, change the order of the 
documents you print, or even switch the priority of background printing over 
the processing of another application program.

 

BJ Printer Status Monitor

 

The BJ Printer Status Monitor checks the status of the printer. If an error 
occurs, the BJ Printer Status Monitor displays the cause of the error and a 
solution. The BJ Printer Status Monitor also detects the remaining ink in the 
BJ cartridge and displays a warning message when the ink is low.

Windows

BJ Backgrounder

BJ Printer Status MonitorBJ Background Monitor
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Printing Your Document

Macintosh

 

For Macintosh users

 

1

 

Select the command used for printing to open the dialog box.

Normally select Print or Page Setup from the File menu.

 

2

 

Specify the necessary print settings in the printer driver. 

 

 

Using the Macintosh Printer Driver
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Printing Your Document

 

3

 

Start printing from the application program.

Click the Print button. Printing begins.

The following screen appears during printing.

When a single Macintosh computer is connected to the printer, and while 
printing from the print server in a network environment, the print progress is 
displayed.

While printing from a client unit in a network environment, the data 
transmission progress to the print server is displayed.

Macintosh
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Loading Plain Paper

This section describes how you load plain paper.

1 Lower the paper output tray.

The paper output tray can be raised while you are not printing.

Paper Output Tray

Note
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Loading Plain Paper

2 To avoid paper jams, fan the stack to remove static cling, then align the 
edges of the stack by tapping it on a flat surface.

3 Load the stack of paper.

• Align the stack with the right side of the auto sheet feeder and insert it 
into the auto sheet feeder. (You can print on either side of plain paper.)

• Slide the paper guide to the left side of the stack until it is snug.

Make sure that the top of the stack is not higher than the load limit mark. 

Load Limit Mark

Paper Guide

Print Side

Note
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Paper Handling

Paper and Other Print Media

Notes on Handling Print Media

Setting the Paper Thickness Lever

Printing on Special Media Types

Artist Canvas

Back Print Film

Banner Paper

Glossy Photo Cards

Glossy Photo Paper

Greeting Cards

High Gloss Film

High Resolution Paper

Magnet Sheets

Transparencies

T-Shirt Transfer

Envelopes

Printing Photographs
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Paper and Other Print Media

This section describes the types of print media you can use with the printer.

�  Ordinary Paper
• Plain Paper

You can use standard photocopier paper. The paper weight must be from 17 to 
28 lb (64 to 105 g/m2). You can also use Canon Bubble Jet Paper.

To prevent paper jams and other problems, never use media heavier than 
28 lb (105 g/m2).

 Specifications

• Envelopes

You can use the standard US Commercial #10 and European DL sizes. You can 
also use the envelopes that come with Canon Greeting Cards. Do not use other 
envelope sizes.

�  Canon Specialty Paper
• Artist Canvas

Use this media to add an artistic touch to your images and artwork. In the printer 
driver, select High Resolution Paper for Media Type and Custom 9.5 × 14 inch for 
Paper Size. 

Note
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Paper and Other Print Media

• Back Print Film 

This white translucent film is ideal for displays that use backlighting to show a 
printed image in the same way as slides and stained glass. The original image 
is reversed (mirrored) when printed. You cannot print on this media using the 
BC-22e Photo BJ Cartridge. 

• Banner Paper

This banner paper allows you to print on up to six connected sheets of letter-size 
paper to create party or advertising banners.

• Brilliant White Paper

Canon’s unique paper formulation gives you a bright white printing surface that 
produces incredibly brilliant colors and dark, crisp black text. This paper works 
great for everyday use, as well as proposals, color presentations, color charts 
and graphs, flyers, and newsletters. You can print on both sides of the sheet. In 
the printer driver, select Plain Paper for the Media Type when you load this 
paper.

• Bubble Jet Paper (water resistant)

The Canon Bubble Jet Paper has been developed for high quality printing with 
minimal or no smearing or running when in contact with water or damp surfaces, 
making it a good choice for damp or rainy environments. The paper is specially 
coated and printable on both sides. (In the printer driver, select Plain Paper for 
the Media Type when you load this paper.)
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Paper and Other Print Media

• Glossy Photo Cards

A special 4.75 × 8.5 inch sheet made of the same stock as Glossy Photo Paper. 
You can obtain a Photo Card printed over its entire area by printing the image so 
that it extends beyond the perforations and then trimming off the unwanted white 
margins. Use this card when you want to print a full 4 × 6 inch photo. 

• Glossy Photo Paper 

This paper is slightly heavier than High Resolution Paper because a gloss 
coating is applied to the print side of the paper. This paper provides near-
photographic quality images with the glossy feel of a photographic print.

• Greeting Cards

Get the most out of your card making software with Canon Greeting Cards. 
These cards give your unique, personalized cards the look and feel of 
professional cards. You can create cards, invitations, announcements, and more. 
These cards come in 1/4-fold and 1/2-fold sizes. In the printer driver, select High 
Resolution Paper for the Media Type.

• High Gloss Film 

A film sheet with a higher gloss than Glossy Photo Paper. To obtain the highest 
quality reproduction of photographs, use this media with the BC-21e Color BJ 
Cartridge. You cannot print on this media using the BC-22e Photo BJ Cartridge. 
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Paper and Other Print Media

• High Resolution Paper

Provides more vivid colors than plain paper. Ideal for printing photographs 
or business documents that include large numbers of color illustrations and 
graphs. For best results, use the optional BC-22e Photo BJ Cartridge to produce 
images comparable to your favorite photographs.

• Magnet Sheets

Printable magnets can be cut to any desired shape or size. In the printer driver, 
select Glossy Photo Paper for the Media Type.

• Transparencies 

Use transparencies to prepare materials for use with an overhead projector. 
To avoid paper jams and other problems, do not use transparencies intended for 
use with other Canon BJ printers, laser printers, or photocopiers. You cannot 
print on this media using the BC-22e Photo BJ Cartridge. 

• T-Shirt Transfer

This is a media for creating iron-on prints for T-shirts. You can make an original 
T-shirt simply by printing your favorite photograph or illustration onto this media. 
The original image is reversed (mirrored) when printed. You cannot print on this 
media using the BC-22e Photo BJ Cartridge. 
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Notes on Handling Print Media

�  Media You Can Use With This Printer
Before you execute a print job, open the printer driver and select the settings that match the 
media loaded in the printer. 

 Using the Windows Printer Driver

 Using the Macintosh Printer Driver

*Stack one sheet of plain paper behind the media before loading in the sheet feeder.

Media Load Limit Print Side
Printer Driver Settings

Page Size Media Type

Plain Paper 50 sheets See package Letter, A4, B5, A5 Plain Paper
Legal Paper 10 sheets See package Legal Plain Paper
Artist Canvas 1 sheet Coated/smooth 9.5 × 14 in. High Resolution Paper
Back Print Film 10 sheets* Matte side Letter, A4 Back Print Film
Banner Paper 1 (2 to 6 sheets) See package Letter, A4 Plain Paper
Brilliant White Paper 50 sheets Either side Letter, Legal Plain Paper
Bubble Jet Paper 50 sheets See package Letter, A4 Plain Paper
Glossy Photo Cards 1 sheet Glossy side Letter, A4 Glossy Photo Cards
Glossy Photo Paper 1 sheet Glossy side Letter, A4 Glossy Photo Paper
Greeting Cards 1 sheet See package Letter, A4 Other Paper
High Gloss Film 1 sheet Film side Letter, A4 High Gloss Film
High Resolution Paper 40 sheets Whiter side Letter, A4 High Resolution Paper
Magnet Sheets 1 sheet Whiter side Letter Glossy Photo Paper
Transparencies 20 sheets* Either side Letter, A4 Transparency
T-Shirt Transfer 1 sheet Unlined side Letter, A4 T-Shirt Transfer
Envelopes
US Com. No. 10
European DL

5 envelopes
5 envelopes

Front side
Front side

#10 Env.
DL Env.

Envelope
Envelope
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Notes on Handling Print Media

�  Paper Handling Guidelines
To avoid poor print quality and possible damage to the printer, do not use the types of 
media listed below.

• Folded paper

• Curled paper

• Creased or crumpled paper

• Damp or wet paper

• Excessively thin media (weight less than 17 lb—64 g/m2)

• Excessively thick media (weight more than 28 lb—105 g/m2)

• Continuous feed paper (tractor feed)

• Punched paper (such as loose-leaf folder inserts)

• Reply-paid postcards (double postal card)

• Postcards with a photograph printed on the reverse side

• Postcards with a photograph or sticker pasted on

• Envelopes with overlapping flaps

• Envelopes with pressure seals

• Envelopes with embossed or treated surfaces

• To avoid touching the print surface, always handle media by the edges. Unclean 
or scratched print surfaces can adversely affect print quality.
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Notes on Handling Print Media

• When storing the print media, put the print media back in its original packaging 
and avoid locations that are exposed to direct sunlight or that are subject to high 
temperatures or humidity.  To avoid curling or wrinkling the paper, store it in a 
level place.

• With the following media, remove each printed sheet from the paper output tray 
as it is ejected, and do not touch the print side until the ink is dry.  Guidelines on 
how long ink takes to dry on each media are as follows.

Artist Canvas About 15 minutes
Back Print Film About 15 minutes
Glossy Photo Cards About 2 minutes
Glossy Photo Paper About 2 minutes
High Gloss Film About 2 minutes
Magnet Sheets About 30 minutes
Transparencies About 15 minutes

• When large amounts of ink are being used, certain types of media may curl 
during printing. If this occurs, move the paper thickness lever to the right. Such 
types of media are most suited for printing of text, and should not be used for 
printing documents that consist mainly of graphics or photographs.
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Notes on Handling Print Media

�  Media Sizes

Non-standard sizes must be within the following limits:

Minimum:  3.94 × 3.94 in. (100.0 × 100.0 mm)
Maximum: 9.5 × 23.0 in. (241.3 × 584.2 mm)

Paper weight must be 17 to 28 lb (64 to 105 g/m2).

Paper Width × Length (mm)

Letter 8.5 × 11.0 in.

Legal 8.5 × 14.0 in.

A4 210.0 × 297.0 mm

A5 148.0 × 210.0 mm

B5 182.0 × 257.0 mm

Glossy Photo Cards 4.65 × 8.43 in. (118.0 × 214.0 mm) Perforation size
4.02 × 5.98 in. (102.0 × 152.0 mm) Finished size

US Commercial #10 envelope 9.5 × 4.1 in.

European DL envelope 220 × 110 mm

Canon Greeting Card envelope 4 × 6 in.
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Setting the Paper Thickness Lever

Set the paper thickness lever to match the media type.

Paper Thickness Lever

Download from Www.Somanuals.com. All Manuals Search And Download.



45Paper Handling

Setting the Paper Thickness Lever

Media Paper thickness lever

Plain paper Left

Artist Canvas Right

Back Print Film Left

Banner Paper Left

Brilliant White Paper Left

Bubble Jet Paper Left

Glossy Photo Cards Left

Glossy Photo Paper Left

Greeting Cards Right

High Gloss Film Left

High Resolution Paper Left

Magnet Sheets Right

Transparencies Left

T-Shirt Transfer Right

Envelopes Right
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Printing on Special Media Types

Artist Canvas

Back Print Film

Banner Paper

Glossy Photo Cards

Glossy Photo Paper

Greeting Cards

High Gloss Film

High Resolution Paper

Magnet Sheets

Transparencies

T-Shirt Transfer

Envelopes
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Printing on Special Media Types

�  Artist Canvas
• Load the Artist Canvas with the print side (coated side) up.

• Load one sheet at a time.

• Set the paper thickness lever to the right.

• Set the Media Type setting in the printer driver to High Resolution Paper.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• Set the Page Size setting to Custom in the printer driver. Then set the Custom page 
size to 9.5" × 14".

• Remove each printed sheet as it is ejected from the printer.

• Do not touch the printed side until the ink is completely dry. About 15 minutes are 
required for drying.

• Return unused sheets to the original package. Store the sheets in a flat, dry, cool 
location away from direct sunlight, high temperature, and high humidity.

• Do not use the BC-22e Photo BJ Cartridge when printing an Artist Canvas.

Windows

Macintosh
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Printing on Special Media Types

�  Back Print Film
This is semi-transparent film used for backlit display. Printed images are reversed 
(mirrored).  

• Do not use the BC-22e Photo BJ Cartridge when printing back print films.

• Load back print film with the printing side (the rougher side) facing up.  

• You can load up to 10 sheets at one time in the sheet feeder.

• Select Back Print Film as the Media Type setting in the printer driver.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each sheet from the output tray as it is ejected.

• Allow about 15 minutes for the ink to dry.

To avoid smudging and prevent printed sheets of back print film from 
sticking together, place a sheet of uncoated plain paper between each 
sheet of back print film. When storing a single sheet of back print film in a 
plastic folder, place sheets of plain paper on both sides of the film.

Print Side 
(Rough Side)

Windows

Macintosh

Note
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Printing on Special Media Types

�  Banner Paper
Banner Paper consists of letter-size sheets that are joined together to make one long strip. 
These are used for printing long posters or banners (up to six sheets in length).

• Printing on banner paper consumes a great deal of ink. If the BJ cartridge is low 
on ink, replace it.

• Position the printer so that the banner paper can hang straight down as it 
emerges.

• Do not allow the banner to touch your desk or floor until the ink is dry. 
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Printing on Special Media Types

• Tear off the number of sheets you want to print, plus one extra.  A maximum of 
six sheets can be printed at one time. In this case, tear off seven sheets. 

• When setting the paper guide, leave a small space along the edge of the paper.

Printing Side
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Printing on Special Media Types

Load the banner paper so that the trailing edge is folded up and not 
hanging down.

• Fold the joint between sheet 1 and sheet 2 upward.

• Set the Media Type setting in the printer driver to Plain Paper.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• Select the Banner Printing option in the printer driver. For Windows, the Banner 
Printing option is on the Page Layout tab. For Macintosh, the Banner Printing 
option is in the Page Setup dialog box. Use your online help for details.

Note

Windows

Macintosh
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Printing on Special Media Types

�  Glossy Photo Cards
This specialized paper has the same qualities as Glossy Photo Paper. By setting the print 
area to extend beyond the perforations, you can use this media type to print cards without 
white margins. This is useful when you want to print a color photo card that covers the entire 
print area.

• Before creating data to be printed, set the size in the application program to 
Photo card.

• Do not tear away the perforations before printing.

• Load with the printing side (the glossier side) facing up.

• Load one sheet at a time.

• Set the Media Type setting in the printer driver to Glossy Photo Cards.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each sheet from the tray as it is ejected.

• Remove the borders along the perforations. See the Glossy Photo Card 
instructions for details.

• Allow about two minutes for the ink to dry.

Windows

Macintosh
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Printing on Special Media Types

�  Glossy Photo Paper
Glossy Photo Paper is thicker than High Resolution Paper and has a glossy surface that 
provides print quality close to that of actual photographs.

• Load one sheet of Glossy Photo Paper at a time.

• Load with the printing side (the glossy side) facing up.

• Load the Loading Support Sheet (B) provided with the paper behind the Glossy 
Photo Paper. See the instructions on the Loading Support Sheet for details.

Do not use Loading Support Sheet (A), which is also included in the 
Glossy Photo Paper package.

Printing Side 
(Glossy Side)

Loading Support Sheet (B)

Note
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Printing on Special Media Types

• Set the Media Type setting in the printer driver to Glossy Photo Paper.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each sheet from the output tray as it is ejected.

• Allow about two minutes for the ink to dry on the Glossy Photo Paper.

�  Greeting Cards
• Refer to the instructions provided with the Greeting Cards package.

• Load one card at a time in the sheet feeder.

• Load the 1/4-fold Greeting Cards with the words “Canon Greeting Cards” facing 
the paper tray.

• Set the paper thickness lever to the right.

• Set the Media Type setting in the printer driver to Other Paper.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• Remove each printed card as it is ejected from the printer.

• Do not touch the printed side until the ink is completely dry. About two minutes 
are required for drying.

• Store unused Greeting Cards in the original package in a dry, cool location away 
from direct sunlight, high temperature, and high humidity.

Windows

Macintosh

Windows

Macintosh
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Printing on Special Media Types

�  High Gloss Film
You can print high quality photographs using this media type with a BC-21e Color BJ 
Cartridge. 

• Do not use the BC-22e Photo BJ Cartridge with High Gloss Film.

• Load this film with the printing side (the glossy side) facing up.

• Load one sheet at a time.

• Set the Media Type setting in the printer driver to High Gloss Film.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each sheet from the output tray as it is ejected.

• Allow about two minutes for the ink to dry on the High Gloss Film.

�  High Resolution Paper
This paper provides superior color development. It is highly suitable for printing business 
documents that contain color graphs, charts, and photographs. 

• Load paper with the printing side (the whiter side) facing up.

• Load up to 40 sheets of paper at a time in the sheet feeder.

• Set the Media Type setting in the printer driver to High Resolution Paper.

Windows

Macintosh
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Printing on Special Media Types

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• You can allow up to 20 sheets to stack in the output tray. However, if the printed 
paper curls, or ink does not dry quickly, remove each sheet as it comes out of the 
printer.

After printing one package of High Resolution Paper, you need to clean the printer rollers 
with the cleaning sheet provided in the pack of paper. This cleans paper dust from inside 
the printer to help reduce sheet feeding problems.

 Cleaning the Paper Feed Rollers

Windows

Macintosh
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Printing on Special Media Types

�  Magnet Sheets
Prepare the Magnet Sheet as follows:

• Place one sheet of plain paper behind one Magnet Sheet. 

• Place both sheets on a hard surface to align the bottom edge and sides. 

Glossy side of Magnet Sheet

Plain paper
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Printing on Special Media Types

• From the bottom edge, roll the two sheets together with the plain paper 
facing out and glossy side of the Magnet Sheet facing inside.

• Once rolled, hold in this position for 20 seconds.

• Unroll the media and place it in the sheet feeder immediately.

• Make sure the print (glossy) side of the Magnet Sheet is facing up when you 
insert it into the sheet feeder.

• Load one Magnet Sheet at a time in the sheet feeder.

• Set the paper thickness lever to the right.

1.5"

1.5"
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Printing on Special Media Types

• Set the Media Type setting in the printer driver to Glossy Photo Paper.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• Remove each printed sheet as it is ejected from the printer.

• Do not touch the printed side until the ink is completely dry. About 30 minutes 
are required for drying.

• Discard the sheet of plain paper.

• Return unused Magnet Sheets to the original package. Store the sheets in a flat, 
dry, cool location away from direct sunlight, high temperature, and high humidity.

• Do not use the BC-22e Photo BJ Cartridge with Magnet Sheets.

Windows

Macintosh
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Printing on Special Media Types

�  Transparencies
This is special film for use in overhead projectors. Do not use transparencies for other 
types of printers or for photocopiers because they will cause paper jams. 

• Do not use the BC-22e Photo BJ Cartridge when printing transparencies. 

• Do not leave transparencies exposed to high humidity. Use them as soon as 
possible after removing them from the package.

• Hold the film by its edge; the film will curl slightly to one side. This side is the 
printing surface. 

Printing Surface
(Curled Side)
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Printing on Special Media Types

• Load transparencies with the printing side facing up.

• You can load up to 20 sheets at one time in the sheet feeder.

• Be sure to set the Media Type to Transparency in the printer driver.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each printed sheet from the output tray as it is ejected.

• Transparencies require about 15 minutes for the ink to dry.

Store printed transparencies with a sheet of uncoated plain paper 
sandwiched between each sheet to prevent the film from sticking to each 
other and to keep the print from smudging. When storing a single sheet of 
film in a plastic folder, place a sheet of plain paper over the printed side.

Print Side

Windows

Macintosh

Note
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Printing on Special Media Types

�  T-Shirt Transfer
You use T-Shirt Transfers for making iron-on appliques for T-shirts. Original T-shirts can be 
created simply by printing your favorite pictures, then ironing them onto a T-shirt. Printed 
images are reversed (mirrored). 

• Do not use the BC-22e Photo BJ Cartridge when printing T-Shirt Transfers.

• Load T-Shirt Transfers with the printing side (the side without the green line) 
facing up.

• Load one sheet at a time.

• Set the paper thickness lever to the right.

• Set the Media Type setting in the printer driver to T-Shirt Transfer. You must select 
T-Shirt Transfer as the Media Type for the image to be reversed.

 Selecting the BJ Cartridge and Media Type

 Changing the Print Dialog Box Settings

• After printing, remove each sheet from the tray as it is ejected. Transfer the 
image to the T-shirt as soon as possible. See the instructions provided with the 
T-Shirt Transfers.

Windows

Macintosh
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Printing on Special Media Types

�  Envelopes
• To assure crisp, clear printing, do not use envelopes with textured or coated 

surfaces. To avoid paper feed problems, do not use double-flap envelopes or 
envelopes with exposed adhesive seals.

• Prepare the envelopes.

1 Press down on the corners and the middle of the envelopes to expel air and 
eliminate warp and curl.

2 If the envelopes are still warped, hold the envelopes at diagonally opposed 
corners and bend lightly. Confirm that the flaps are straight.
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Printing on Special Media Types

3 For more reliable feed, make sure the flaps lie flat by rubbing with the tip of 
a pen.

�  Loading Envelopes
• Load envelopes with the address side facing up (with the flap side facing down).

• You can load up to five envelopes in the sheet feeder.

• Be sure to set the paper thickness lever to the right.

• Set the Media Type to Envelope in the printer driver.

• Do not allow more than five envelopes to stack up in the output tray.

Print Side
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Printing Photographs

�  Tips for Printing Photographic Images
To produce the best possible print quality for printing photographic images from a digital 
camera or scanner, or photographic images downloaded from a home page on the Internet, 
follow these guidelines.

• Use the BC-22e Photo BJ Cartridge.

• Use special media designed for reproducing photographs.

• Use the correct print settings in the printer driver.

1 Make sure that the printer is plugged in. Also, make sure the BC-22e Photo 
BJ Cartridge is installed.

2 Load special print media in the auto sheet feeder of the printer.

Excellent prints of photographs can be obtained with plain paper, but for 
superior color reproduction, use one of the following special media:

 High Resolution Paper

 Glossy Photo Paper

 T-Shirt Transfer 
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Printing Photographs

3 Adjust the printer driver settings. 

 For Windows users

 For Macintosh users

For optimum reproduction of all the color tones, make sure that 
the Media Type setting is correct for the media you have loaded 
in the printer.

  For Windows users 

1 Open the Printer Properties dialog box and click on the Main tab.  

2 Select SuperPhoto in the Choose Print Mode box. When SuperPhoto is 
selected, the BJ Cartridge setting automatically changes to Photo and the 
Media Type changes to High Resolution Paper. Make sure these settings 
match the BJ cartridge and media you have installed.

3 Click the OK button to close the Printer Properties dialog box.

4 Start the print job.

Note

Windows
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Printing Photographs

For Macintosh users

1 Select the command used for printing (for example, Print from the File 
menu) to open the Print dialog box.

2 Select the Photo icon in the Print dialog box.

3 Select Photo in the BJ Cartridge setting, and click the Print button.

�  About Photo Optimizer
The Photo Optimizer adjusts a photographic image created with a digital camera when it is 
printed out. Use the Photo Optimizer to compensate unsatisfactory color balance and over- 
or underexposure before printing.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Click the Advanced button.

3 Select Photo Optimizer in the Quality tab.

Macintosh

Windows

Download from Www.Somanuals.com. All Manuals Search And Download.



68Paper Handling

Printing Photographs

4 Check the Whole Page checkbox, if necessary.

Enabled: When the Whole Page setting is enabled, the Photo Optimizer 
adjusts multiple photographic images appearing on the same 
page separately.  Use this setting when any trimmed or rotated 
images are contained in the page.

Disabled: When the Whole Page setting is disabled, the Photo Optimizer 
adjusts multiple graphic images appearing on the same page as 
a whole.

1 Select Photo Optimizer in the Quality panel. 
The Photo Optimizer feature works on the image that is edited using the 
edit menu such as “Cut” and “Rotate” in a graphics application program.  

Macintosh

Disabled Enabled
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Using BJ Cartridges

Types of BJ Cartridges

BJ Cartridge Guidelines

Replacing Ink Tanks

Replacing the BJ Cartridge

Download from Www.Somanuals.com. All Manuals Search And Download.



70Using BJ Cartridges

Types of BJ Cartridges

This section describes the BJ cartridges that you can use with the printer. Select the 
BJ cartridge that best meets your particular print job.

�  BC-21e Color BJ Cartridge (included with printer)
Use this BJ cartridge for standard high-quality color printing.

BCI-21 Black 
Ink Tank

BCI-21 Color 
Ink Tank

BC-21e Color 
BJ Cartridge

BJ Cartridge 
Without Ink Tanks
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Types of BJ Cartridges

The BC-21e Color BJ Cartridge contains two replaceable ink tanks:

• BCI-21 Color Ink Tank
Contains Cyan, Magenta, and Yellow (CMY) inks.

• BCI-21 Black Ink Tank
Contains only black ink. 

The following BJ cartridges consist of a print head and ink tank sealed in one unit. When 
this BJ cartridge runs out of ink, discard the entire print head unit. 

�  BC-20 Black BJ Cartridge (optional)

Use this BJ cartridge for black and white text that does not require 
color printing.

�  BC-22e Photo BJ Cartridge (optional)

The BC-22e Photo BJ Cartridge is designed to produce photo-
quality color printing.
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BJ Cartridge Guidelines

• Always store BJ Cartridges and ink tanks safely out of the reach of small 
children. If a child inadvertently licks a BJ cartridge or ink tank or ingests any ink, 
consult a physician immediately.

• Do not leave an empty ink tank in a BJ cartridge. Remove it immediately after ink 
runs out.

• To maintain optimum print quality, use up a BJ cartridge within one year after 
installation and ink tanks within six months of installation.

�  When to Replace the BJ Cartridge
When your printed text is faint or the printed colors are wrong, print a Nozzle Check Pattern 
and check the status of the print head. Based on the results of the Nozzle Check Pattern, 
clean the print head and replace the ink tank or BJ cartridge if required.
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BJ Cartridge Guidelines

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

 Replacing Ink Tanks

 Replacing the BJ Cartridge

• Print a Nozzle Check Pattern

• Clean the Print Head

BC-20 Black BJ Cartridge
BC-22e Photo BJ Cartridge

BC-21e Color BJ Cartridge

• Change the Ink Tank(s)

• Replace the BJ cartridge
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Replacing Ink Tanks

When using the BC-21e Color BJ Cartridge, you can replace the ink tanks when they run 
out of ink.

When you purchase extra ink tanks, specify the BCI-21 Color Ink Tank or BCI-21 Black Ink 
Tank.

Make sure the printer is connected to the power outlet.

1 Open the front cover. The cartridge holder moves to the center. 
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Replacing Ink Tanks

2 Pull the tab on the ink tank toward you to release it. Then pull it out of the 
slot.

• To avoid staining your hands, clothing, or areas of the work site, do not 
shake or drop the ink tank when you are handling it. Also, do not press 
in on the sides of the ink tank.

• Dispose of the ink tank immediately to prevent spilling and staining.

• Be sure to leave the BJ cartridge in the printer.

Note
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Replacing Ink Tanks

3 Remove a new ink tank from its package and remove the protective orange 
cap.

• To avoid staining your hands, clothing, or areas of the work site, do not 
shake or drop the ink tank when you are handling it. Also, do not press 
in on the sides of the ink tank.

• Discard the protective cap immediately. Do not attempt to reattach the 
cap once removed.

• To avoid interfering with the ink supply from a tank, do not touch an open 
ink port on the ink tank.

Protective Cap

Note
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Replacing Ink Tanks

4 Slide the new ink tank into the slot.

5 Firmly push the ink tank tab down and back into an upright position until the 
tank locks into place.
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Replacing Ink Tanks

6 Close the front cover.

• The cartridge holder moves to the home position on the right side of the 
printer.

• The printer automatically cleans the print head unit.

Note
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Replacing the BJ Cartridge

When a BC-20 Black BJ Cartridge or BC-22e Photo BJ Cartridge runs out of ink, or when 
you want to switch a BJ cartridge with another one, follow the procedure below to change 
the BJ cartridges.

Make sure the printer is connected to the power outlet.

1 Open the front cover. The cartridge holder moves to the center of the 
printer.
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Replacing the BJ Cartridge

2 Raise the blue cartridge lock lever on the right side of the cartridge holder 
to unlock the cartridge holder.

3 Lift the BJ cartridge out of the cartridge holder.
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Replacing the BJ Cartridge

If you are replacing a depleted BJ cartridge, dispose of it immediately. 

If you are exchanging BJ cartridges for a special print job, hold the 
BJ cartridge with the label facing you and the print head down and 
store it in the SB-21 Ink Cartridge Storage Box.

Always hold the BJ cartridge by its sides. Never touch the silver plate, 
print head, or the sharp edges around the print head.

Note
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Replacing the BJ Cartridge

4 Take the new BJ cartridge out of its package.

Remove the orange protective cap and tape.

5 Set the BJ cartridge into the cartridge holder. Then lower the cartridge lock 
lever until it locks into place.

Protective Cap Protective Tape
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Replacing the BJ Cartridge

6 Set the paper thickness lever for the type of media that you are going to 
load.

 Setting the Paper Thickness Lever

7 Close the front cover.

• The cartridge holder moves to the home position on the right side of the 
printer.

• The printer automatically cleans the print head unit.

Note
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Using the Windows Printer Driver

Printer Driver Basics

Opening the Printer Properties Dialog Box

Selecting the Print Mode

Setting the Page Size

Confirming the Paper Feed

Using Online Help

Closing the Printer Properties Dialog Box
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

You’ll also want to use the online Help to learn more about the functions of 
the printer driver.

 Using Online Help

Note
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Opening the Printer Properties Dialog Box

When you specify the print settings or use maintenance functions such as print head 
cleaning, open the Printer Properties dialog box. There are two different ways to open the 
Printer Properties dialog box: from your application program or from the Start menu.

This section describes the general procedures for opening the Printer 
Properties dialog box. Depending on the application program you use, 
different menu items may be used for printing. For more details, refer to the 
User’s Manual for your application program.

�  From Your Application Program
You can open the Printer Properties dialog box from your application program before 
printing.

1 Select the command used for printing (for example, Print or Print Setup in 
the File menu) in your application program.

Note
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Opening the Printer Properties Dialog Box

2 Make sure that Canon BJC-2100 is selected in the Printer box.

If another printer name is displayed, click the down-arrow and then select 
Canon BJC-2100 from the pull-down list.
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Opening the Printer Properties Dialog Box

3 Click the Properties button. The Printer Properties dialog box opens. Make 
sure that the Main, Page Layout, Stamp/Background, and Maintenance 
tabs are displayed in the Printer Properties dialog box.
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Opening the Printer Properties Dialog Box

�  Directly From the Start Menu
When you wish to specify print settings that are common to all application programs, open 
the Printer Properties dialog box directly from the Start menu.

This method is also helpful when you wish to use maintenance functions such as print head 
cleaning without starting up an application program.

1 Click the Start button. Point to Settings, then click Printers.

2 When the Printers window is displayed, click the Canon BJC-2100 icon.
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Opening the Printer Properties Dialog Box

3 Select Properties from the File menu. The Printer Properties dialog box 
opens. Make sure that the Main, Page Layout, Stamp/Background, and 
Maintenance tabs are contained in the Printer Properties dialog box.

When you open the Printer Properties dialog box directly from the Start 
menu, some other tabs (such as General and Details) are added by the 
Windows operating system. For more details on these additional tabs, 
refer to your Windows documentation.

Note
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Selecting the Print Mode

Before you start a print job, open the Printer Properties dialog box and specify the print 
mode. The print settings in the Printer Properties dialog box allow fine control over the print 
quality and color adjustment, but you can simplify the setup procedure by selecting the icon 
in which the most appropriate print settings are pre-assigned.

�  Selecting a Default Print Mode
The following print modes are set up as defaults in the printer driver. When you select an 
icon in the Choose Print Mode box, the combination of BJ Cartridge and Media Type 
settings changes automatically. Select the most appropriate icon according to your print job.

Print Mode 
Icon Purpose BJ Cartridge Media Type

For printing documents that consist 
mostly of text (such as word processor 
files) at the standard print quality.

Color Plain Paper

Gives priority to print speed rather than 
print quality. Use this print mode for trial 
printing.

Color Plain Paper
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Selecting the Print Mode

• In addition to the BJ Cartridge and Media Type settings, other print 
settings are also pre-assigned in each icon in the Choose Print Mode box. 
To confirm all default settings, click the Advanced button after selecting 
the icon. The settings in the Quality, Special Effects, and Color tabs are 
the properties of the print mode.

• You can modify the default print mode settings, as necessary.

• To learn about all the features of the printer driver, use the online help.

 Using Online Help

Automatically recognizes photographs 
and graphics and prints using the 
optimum print settings. This print mode is 
the best choice when you print data that 
contains different elements such as text, 
tables, graphs, and photographs in the 
same document.

Color Plain Paper

Produces high print quality for printing 
photographs and other graphics with fine 
gradations of tone.

Color High 
Resolution 
Paper

Produces the best possible print quality 
for printing photographs. This print mode 
is also suitable for printing graphics with 
fine gradations of tone.

Photo Glossy 
Photo Paper

Print Mode 
Icon Purpose BJ Cartridge Media Type

Note
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Selecting the Print Mode

�  Selecting the BJ Cartridge and Media Type
After you select the icon, match the BJ Cartridge and Media Type settings with the 
BJ cartridge and print media installed in the printer.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Select the desired icon according to your print purpose in the Choose 
Print Mode box.

3 Make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and print media installed in the printer.
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Selecting the Print Mode

When you change a default setting in the BJ Cartridge or Media Type box, 
the icon that indicates the current settings changes to User-modified.

You can start a print job with the User-modified icon, or you can save the settings in the 
Choose Print Mode box under a new icon.

Use the online help feature to learn how to save the modified settings.

 Using Online Help

Note

Current Setting
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Setting the Page Size

Set the page size you use from within the application program before printing. Also make 
sure that the Page Size setting in the Printer Properties dialog box is identical to the paper 
size setting in the application program.

�  Confirming the Page Size
You can view the size of paper you use in the print settings information box of the Main tab. 
Make sure that Page Size is identical to the setting in the application program before 
printing.

If this information is not correct, click on the Page Layout tab and make the correct 
selections.

Print Settings 
Information Box
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Setting the Page Size

�  Changing the Page Size (for standard paper sizes)

1 Click the Page Layout tab.

2 Click the down-arrow in the Page Size box, then select the appropriate 
page size from the pull-down list.

Download from Www.Somanuals.com. All Manuals Search And Download.



97Using the Windows Printer Driver

Setting the Page Size

�  Changing the Paper Size (for custom paper sizes)

1 Click the Page Layout tab.

2 Click the down-arrow in the Page Size box, then select Custom Size from 
the pull-down list.

The Custom Page Size dialog box is displayed.
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Setting the Page Size

3 Select inches or millimeters for the unit of measurement in the Unit box, 
and enter the desired width and height within the following ranges:

width: 3.94" to 9.50" (100.0 mm to 241.3 mm)
height: 3.94" to 23.0" (100.0 mm to 584.2 mm)

4 Click the OK button.
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Confirming the Paper Feed

You can view the paper feed method in the illustrated guideline in the Main tab.

If this information is not correct, click on the Page Layout tab and make the correct 
selections. Use the online help feature to find out about the Settings on the Page Layout 
tab.

 Using Online Help

Manual Feed is not available for the BJC-2100. Only Auto Feeder is 
provided.

Illustrated Guideline

Note
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Using Online Help

When you want to learn about a particular topic, the online help function provides the 
necessary information on the screen of your computer. Use the online help to learn about 
all the features of your printer driver.

�  Finding Information on a Particular Topic

1 When you click the ? button on the upper right corner of the Printer 
Properties dialog box, the shape of the mouse pointer changes to .

2 Click the desired item to learn more about the item. A detailed explanation 
appears.
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Using Online Help

�  Finding Information on an Operation Procedure

1 Click the Help button on the lower right corner of the Printer Properties 
dialog box.

2 When the contents of the Canon BJ Printer Driver Help are displayed, 
select the desired item to learn more about the item.

To find an item you want information about, click the Index or Find tab and 
enter a keyword.
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Closing the Printer Properties Dialog Box

After specifying the necessary print settings, close the Printer Properties dialog box and 
start your print job.

1 Make sure the information on the tabs is correct.

2 Click the OK button. The print settings become enabled and the Printer 
Properties dialog box closes.
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Closing the Printer Properties Dialog Box

• To set the print settings without closing the Printer Properties dialog box, 
click the Apply button.

• To ignore any changes you have made, click the Cancel button.

• To change the print settings back to the factory settings, click the 
Defaults button.

Note
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Using the Macintosh Printer Driver

Printer Driver Basics

Selecting a Printer Driver

Changing the Page Setup Dialog Box Settings

Changing the Print Dialog Box Settings

Using Balloon Help

Using Background Printing

Using the Printer With a Network
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

You’ll also want to use the online Help to learn more about the functions of 
the printer driver.

 Using Balloon Help

Note
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Selecting a Printer Driver

Before using the Page Setup dialog box and the Print dialog box, you must first go into 
Chooser in the Apple Menu and choose the correct printer driver. 

�  Selecting the Printer Driver Using Chooser
• Make sure the printer is connected to your Macintosh. 

1 Select Chooser from the Apple Menu.

The Chooser is displayed.

2 Click the BJC-2100 icon.
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Selecting a Printer Driver

3 To perform background printing, set Backgrounding to On.

4 Click in the close box to close the Chooser. You can now use the BJC-2100 
for printing.

Close BoxClose Box

Click On
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Changing the Page Setup Dialog Box Settings

The size of the paper used for printing is usually set when a document is created with an 
application. In your application, open the Page Setup dialog box and select the paper size 
you are using with your printer.

�  Selecting the Paper Size and the Orientation
You can open the Page Setup dialog box from your application program. 

1 Select the command used for Page Setup in your application program.

Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.

2 Click on Paper Size, and then select the appropriate paper size from the 
pop-up menu.
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Changing the Page Setup Dialog Box Settings

3 Select Orientation.

4 Click the OK button. The Page Setup dialog box closes.

�  Selecting the Paper Size (for custom paper sizes)
When you use custom paper sizes, select any one of Custom1 to Custom3.

1 Select the command used for Page Setup in your application program.

Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.

Depending on the application, more options may be displayed.
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Changing the Page Setup Dialog Box Settings

2 In Paper Size, select any one of Custom1 to Custom3 and then click the 
Custom button.

The Custom dialog box is displayed. 

3 Select inches or millimeters for the unit of measurement in Unit and enter 
the desired width and height.

4 Click the Apply button. 

The Custom dialog box closes and the specified paper size is set.

• Any of Custom1 to Custom3 can be specified as the user-defined paper 
size.

• To make the setting made with the Page Setup dialog box the default, so 
that it is automatically selected whenever a new document is created, 
place a check mark in the Save Settings checkbox.

Note
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Changing the Print Dialog Box Settings

Before you can start printing, you’ll want to make a few basic settings. Set the BJ Cartridge 
and Media Type settings to match your printer setup, then select the icon that corresponds 
to the print mode you want to use to print your document.

�  Setting the Print Mode and Starting to Print
This section explains how to make the required settings before you start printing. You must 
enter values for Copies, Pages, BJ Cartridge, Media Type, and Print Mode.

This section describes the general procedure for opening the Print dialog box from an 
application program. Depending on the program you are using, different menu items may 
be used for printing. For more details, refer to the User's Manual for your application 
program.

1 Select the command you use for Printing in your application program.

Normally, click Print from the File menu, and the Print dialog box is 
displayed.
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Changing the Print Dialog Box Settings

2 Enter the number of copies to be printed, and then set which pages are to 
be printed.

When only certain pages of a document are to be printed, click the From 
button and enter the first and last print pages. 

Note
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Changing the Print Dialog Box Settings

3 Select BJ Cartridge and Media Type.

Click the up- or down-arrow to display a pop-up menu. 

• When a document created in color is to be printed out in monochrome, 
place a check mark in the Print Grayscale checkbox.

•  Paper Feed includes only Auto Feeder as a selection item.

Note
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Changing the Print Dialog Box Settings

4 Select the Print Mode icon.

Select the icon that is closest to your document type and intended results. 
The Current Settings shows the name of the selected icon, along with 
information on the Halftoning and Color Correction for the selected Print 
Mode.

Print Mode Icons

Text Prints documents made up primarily of text at 
normal quality.

Graphic Intended for printing graphs and other computer 
graphics with clear color boundaries.

Photo Intended for printing photographs and other 
graphics that use gradations of color and Tone.

Manual Allows you to customize the print mode settings. 

5 Click the Print button to close the Print dialog box and start the print job.
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Changing the Print Dialog Box Settings

�  Displaying a Print Preview of the Document 
To view a preview of the document as it will appear when printed, click the Options... button 
and change the output destination.

1 Open the Print dialog box, and click the Options... button.

The Options dialog box is displayed.

2 Select Preview as the output destination, and click the OK button.
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Changing the Print Dialog Box Settings

3 Click the Preview button in the Print dialog box.

The Preview dialog box is displayed.
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Changing the Print Dialog Box Settings

When the preview screen is displayed as a result of selecting manual for 
Print Mode, you can adjust the Color Balance and Density Settings. 

4 When you are satisfied with the document and want to print it, click the 
Print button. To close the preview screen without printing, click the Cancel 
button.

�  Saving a Document as a PICT File
To save your document as a PICT file, click the Options... button and change the output 
destination.

1 Open the Print dialog box, and click the Options... button. The Options 
dialog box is displayed.

2 Select PICT File as the output destination, and click the OK button.

Note
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Changing the Print Dialog Box Settings

3 Click the File button in the Print dialog box.

4 Type in the name under which you want to save and click the Save button.

The document data is saved in PICT file format.
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Using Balloon Help

Turn on balloon help to display an explanation of each function on the screen. When you 
position the cursor over a given item, a brief explanation of that item appears in a balloon. 
Use the balloon help to learn about all the features of your printer driver.

�  Displaying Balloon Help
To display the balloon help, select Show Balloons from the Help menu. Position the pointer 
over the desired item to display a balloon help explanation.

1 Select Show Balloons from the Help menu.

2 Display the printer driver screens (the Page Setup dialog box, the Print 
dialog box, and so forth).

3 Position the cursor over the item for which you want to display an 
explanation. An explanation of the item is displayed.

To turn off the balloon help, select Hide Balloons from the Help menu.Note
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Using Background Printing

If background printing is selected with Chooser, you can open the BJ PrintMonitor to 
confirm the progress of printing or to stop printing. Also, you can change the order in which 
suspended documents are printed.

�  About Background Printing
The print processing method that enables you to do other tasks simultaneously while 
printing documents is called “Background Printing.” To perform background printing, select 
Chooser from the Apple Menu, select a printer driver and set Backgrounding to On.

During background printing, you can display the BJ PrintMonitor to confirm the progress of 
printing or to stop the printing.

�  Displaying the BJ PrintMonitor Window
When Backgrounding is set to On, the BJ PrintMonitor starts up automatically when you 
print. The BJ PrintMonitor appears in the Application Menu. To verify the print process, click 
the BJ PrintMonitor icon in the Application Menu.
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Using Background Printing

�  Closing the BJ PrintMonitor Window
When you select Close Status Window from the File menu, the BJ PrintMonitor window 
closes.
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Using Background Printing

�  BJ PrintMonitor Function
The BJ PrintMonitor shows the document currently being printed and a list of the 
documents queued for printing. Print queue document information includes the document 
name, number of pages, number of copies, and the time when the print job was accepted. 
The total number of print queue documents is displayed in the bottom row.

Control Buttons

Suspends printing of the 
document. Restarts the printing 
of the document.

Suspends the printing of specified 
documents only.

Restarts the printing of the 
documents suspended with .

Stops printing of the specified 
document.

Shows information on the document 
currently being printed. The icon on the 
left gradually fills with black as printing 
proceeds.

Lists the names of the queued 
documents.
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Using Background Printing

The BJ PrintMonitor makes it possible to perform the following tasks.

• You can change the order of the documents in the print queue. Position the 
cursor over the name of the document whose position you want to change and 
drag it to the desired position in the queue while holding down the mouse button. 
When you release the button, the document moves to the selected position. You 
can temporarily suspend the printing of one document so that another document 
in the print queue can be printed out.

• You can stop printing.
Click the document name you want to stop printing and then click the  icon. 
The selected document is deleted from the list.

• You can suspend or restart printing.
Click the name of the document you want to suspend printing and then click 
the  icon. To restart printing, click the  icon.
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Using the Printer With a Network

The BJC-2100 Series printer can be connected to a network. To enable use of the printer 
from any computer connected to the network, the BJC-2100 printer driver must be installed 
on each computer.

�  Connection Environment and Installation
• The BJC-2100 can be connected to an Ethernet environment.

• Install the printer driver on all the computers with USB that will use this printer.

• The printer must be connected to the computer acting as the print server via a 
USB interface cable. The print server and the client machines use different 
printer drivers and different tools to confirm printing progress. Refer to the 
example shown below.

Client Machine Client Machine

Client 
Machine

Client Machine Client Machine

Print Server

USB Interface 
Cable

BJC-2100 Series Printer

Ethernet
Environment
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Using the Printer With a Network

Print server
Refers to the computer to which the printer is directly connected via a USB interface cable. 
On the print server, select the printer driver called BJC-2100. From the print server, the 
progress of printing can be confirmed using the BJ PrintMonitor.

Client machine
Refers to a computer that is connected to the print server via an Ethernet network. From a 
client machine, select the printer driver called BJC-2100 (Server). When printing is 
executed, data is sent to the printer via the print server. From a client machine, the progress 
of printing can be confirmed by starting the BJ StatusMonitor on the print server.

�  Selecting the Printer Driver
To use the printer with a network, the correct printer driver must be installed on each 
computer. 

First, set up the print server. Then, make the necessary settings for each client machine.

Setting up the print server

1 Select Chooser from the Apple Menu and make AppleTalk active.
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Using the Printer With a Network

2 Select the BJC-2100 icon and select the printer name from Connected to:.

3 Click the Share button.
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Using the Printer With a Network

4 Confirm that BJC-2100 server is selected for Enter New Print Server 
Name:, and then click the Send button.

5 Confirm that a new print server name has been added to Current Print 
Servers, and then click the Close button.

6 Click the closebox to close the Chooser.

You can enter any desired name in the Enter New Print Server Name box. Note
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Using the Printer With a Network

Setting up client machines

1 Select Chooser from the Apple Menu and make AppleTalk active.

2 Select the BJC-2100 (Server) icon and select the print server in Connected 
to:.

3 Click the closebox to close the Chooser.
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Using the Printer With a Network

�  Confirming the Status of the Print Server from a Client Machine
When the progress of printing with the print server is to be confirmed in the BJ PrintMonitor, 
start the BJ StatusMonitor.

Starting the BJ StatusMonitor

Double-click the BJ StatusMonitor icon in the BJ Extra folder.
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Using the Printer With a Network

Select a print server on which you can check printing progress.

1 Select Print Server Selection from the File menu.

2 Select a printer and a printer server on which you can check printing 
progress.

If AppleTalk Zone is set, select a zone that includes a print server on which 
you can check printing progress.

Closing the BJ StatusMonitor window

Select Quit from the File menu to close the BJ StatusMonitor.

Note
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Using the Printer With a Network

Functions of the BJ StatusMonitor

The progress of print jobs being performed by the print server can be confirmed using the 
BJ StatusMonitor. A list of documents that are currently being printed as well as those in the 
print queue is displayed. The information related to the jobs in the print queue includes the 
document name, number of pages, number of copies, and the time at which the print job 
was accepted. The total number of documents in the print queue is displayed in the bottom 
row.

Functions of the buttons

Suspends the printing of 
specified documents only.

Restarts printing of the 
documents suspended with .

Stops printing of the specified 
document.

Displays information related to the 
document currently being printed.
The icon on the left gradually fills with 
black as printing progresses.

Lists the names of the queued 
documents.
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Using the Printer With a Network

The following operations can be performed with the BJ StatusMonitor. Note, however, that 
the owner of the client machine and the owner of the document must be the same. If you 
double-click a document name, you can determine the owner of the print job.

• Stop printing
Click the name of the document for which you want to stop printing and then click 
the  icon. The selected document is deleted from the list.

• Suspend/Restart printing
Click the name of the document for which you want to suspend printing and then 
click the  icon. To restart printing, click the  icon.

• The owner of a computer can be determined from the Owner Name item 
after selecting File Sharing from the control panel.

• When you are using two or more print servers, you can switch the 
display of BJ StatusMonitor. Select the desired print server from Print 
Server and then click the OK button. You can then switch the display of 
the BJ StatusMonitor.

Note
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Maintaining the Printer

Cleaning the Printer

Printing a Nozzle Check Pattern

Cleaning the Print Head

Cleaning the Paper Feed Rollers

Transporting the Printer
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Cleaning the Printer

The inside of the printer may become soiled with ink and paper dust as the printer is used.

1 Unplug the printer from the power outlet.

If you have been using the printer, wait at least one minute before 
proceeding.
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Cleaning the Printer

2 Open the front cover and wipe inside the printer with a clean dry cloth.

Look for sprayed ink, paper dust, or scraps of paper especially around the 
platen. Avoid touching parts inside the printer such as the cartridge holder.

• To avoid serious personal injury, never use flammable solvents such as 
thinners, benzene or alcohol to clean the printer. If such substances 
come in contact with electrical components inside the printer, they could 
cause a fire or electric shock.

• Always unplug the printer from the power outlet when you are cleaning it. 
You could touch moving parts inside the printer and suffer injury if you 
clean the printer while it is still on.

Platen

Caution
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Printing a Nozzle Check Pattern

The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles. Print the Nozzle Check Pattern when your printouts are streaked or the 
color tones are not correct, or after print head cleaning. 

Make sure that the printer is plugged in and more than one sheet of plain paper is loaded in 
the printer. 

 For Windows users

 For Macintosh users

The following sections describe how to print the Nozzle Check Pattern using your printer 
driver. You can also print the Nozzle Check Pattern directly from the printer. Press the 
RESUME button twice quickly.
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Printing a Nozzle Check Pattern

 For Windows users

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the Nozzle Check Pattern icon in the Test Prints box.

3 When a confirmation message appears, click the OK button.

Windows
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Printing a Nozzle Check Pattern

 For Macintosh users

1 Select Page Setup from the File menu, then click the Utilities button.

2 Select Test Print.

Macintosh
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Printing a Nozzle Check Pattern

3 Select Nozzle Check Pattern.

4 When a confirmation message appears, click the OK button.
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Printing a Nozzle Check Pattern

�  Examining a Nozzle Check Pattern
The patterns show the status of the BJ cartridge.

BC-21e Color BJ Cartridge or BC-22e Photo BJ Cartridge

Black BJ Cartridge

If the pattern is broken or missing, or a specific color is not printed, clean the print head.

 Cleaning the Print Head

24
24
24
64

24
24
24

24
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Cleaning the Print Head

Cleaning the print head clears the nozzles. 

Cleaning the print head consumes ink so clean the print head only when 
necessary.

Make sure that the printer is plugged in.

The following sections describe how to start print head cleaning from the printer driver.

 For Windows users

 For Macintosh users
  

Note
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Cleaning the Print Head

For Windows users

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Select the print head cleaning icon in the Print Head Cleaning box.

3 When a confirmation message appears, click the OK button.

Cleaning begins; this takes approximately 30 seconds.

Windows
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Cleaning the Print Head

For Macintosh users

1 Select Page Setup from the File menu, then click the Utilities button.

2 Select Print Head Cleaning.

Macintosh
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Cleaning the Print Head

3 Click the OK button.

The Cleaning begins. Completion takes approximately 30 seconds.
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Cleaning the Paper Feed Rollers

If you frequently print on specially coated paper, like High Resolution Paper, paper dust will 
accumulate inside the printer and may adversely affect paper feed. To prevent this, clean 
the feed rollers using the cleaning sheet provided in the packet of coated paper.
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Cleaning the Paper Feed Rollers

1 Peel the two pieces of tape off the cleaning sheet.

2 Load the cleaning sheet

• Load the sheet with the taped side facing up and the sticky pads down. 
• Slide the paper guide snug against the left side of the cleaning sheet.
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Cleaning the Paper Feed Rollers

3 Start cleaning.

Open the Printer Properties dialog box, click the Maintenance tab and then 
click the clean paper feed rollers icon.

Select Page Setup from the File menu, then click Utilities and click the Feed 
Rollers Cleaning icon.

4 When you are prompted to confirm the cleaning, click the OK button.

Do not re-use a cleaning sheet. Important

Windows

Macintosh
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Transporting the Printer

Use the original box and packing material to repack the printer for shipping or moving to 
another location. (When you do not use the original box, make sure that the printer is 
packaged properly so that it does not get damaged during the transportation.)

1 Open the front cover and remove the BJ cartridge from the cartridge holder. 
Store the removed BJ cartridge in the SB-21 Ink Cartridge Storage Box.

2 Remove the paper rest and the paper output tray from the printer.

3 Unplug the power cord from the power outlet.
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Transporting the Printer

4 Disconnect the printer cable from the computer and printer. Also, 
disconnect the power cord from the printer.

5 Reattach the tape to the printer and insert the printer into its plastic bag. 

Tape
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Transporting the Printer

6 Fit the packing material on either end of the printer and pack the printer into 
the original box.

If you are shipping the printer through a shipping agent, mark the box with 
“FRAGILE” or “HANDLE WITH CARE”.

Note
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Troubleshooting

Printout Is Unsatisfactory

Printer Does Not Start or Stops Mid-job

Paper Jams or Does Not Feed

An Error Message Appears

Other Problems

Before You Call for Help

Getting Help From Canon
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Printout Is Unsatisfactory

Color Document Printed in Monochrome
Colors Not Clear
Printed and On-screen Colors Do Not Match
Printout Does Not Match the Document Displayed on the Screen
Printed Text Rotated 90 Degrees
Printing in Top Left Corner
Text Cut Off at Bottom Right Corner, Right Edge, or Bottom Edge
Text or Image Reversed (Mirrored)
Enlarged/Reduced Printing Not Correct
Single Page Prints Over Two or More Pages
Colors Streaked or Incorrect
Straight Lines Are Broken
Printed Pages Curled
Backs of Pages Stained With Ink
Ink Blurred
Printed Surface Scratched
White Streaks Visible
Colors Streaked or Uneven
Last Part of Print Job Not Printing
Characters and Figures Notched / Gradation Streaked or Unnatural 
Color Document Not Satisfactory
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Printout Is Unsatisfactory

�  Color Document Printed in Monochrome
A document created in color is printed in monochrome.

CHECK 1 BC-20 BLACK BJ CARTRIDGE INSTALLED?

Color printing is not possible using the BC-20 Black BJ Cartridge. Replace 
it with a suitable color cartridge, such as the BC-21e Color BJ Cartridge or 
BC-22e Photo BJ Cartridge depending on your application.

 Replacing the BJ Cartridge

CHECK 2 BLACK SELECTED IN THE PRINTER DRIVER?

Confirm that the BJ cartridge setting in the printer driver dialog box is not 
Black and that it matches the type of cartridge installed.

 Types of BJ Cartridges

CHECK 3 GRAYSCALE PRINT SELECTED?

Open the Printer Properties dialog box and disable 
Grayscale Print in the Main tab.

Disable Print Grayscale on the left bottom corner of the 
Print dialog box.

Windows

Macintosh
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Printout Is Unsatisfactory

CHECK 4 MONOCHROME PRINTING SELECTED IN APPLICATION PROGRAM?

Some application programs have a setting in the print dialog box that 
allows you to enable or disable color printing.

Check that the setting is enabled in the application program.

For details, refer to the documentation of the application program.

CHECK 5 CORRECT PRINTER DRIVER SELECTED?

If the wrong printer driver (one that supports only monochrome printing) 
is selected, all the documents are printed in monochrome.

Start the print job again and check that “Canon BJC-2100” is displayed in 
the Name entry box of the Print dialog box.

If the name of another printer is displayed, click the down-arrow and select 
“Canon BJC-2100” from the pull-down list.

To avoid this problem, set the BJC-2100 as the default printer. To do so, 
click Start, select Settings, and click on Printers. Highlight the Canon 
BJC-2100 icon and right-click. Now click the Set As Default option (make 
sure a check mark appears).

Windows

Note
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Printout Is Unsatisfactory

�  Colors Not Clear
The colors in printed photographs and illustrations are not as clear as you expected.

CHECK 1 BJ CARTRIDGE AND MEDIA CORRECT FOR THE PRINT JOB?

When printing photographs or illustrations, use High Resolution Paper, 
Glossy Photo Paper, or High Gloss Film. These media provide better color 
reproduction and brighter colors than plain paper.

If you are printing graphs or charts, use the BC-21e Color BJ Cartridge. 
The BC-22e Photo BJ Cartridge is the best choice for natural images with 
fine color gradations, such as photographs.

A clogged or worn BJ cartridge may cause printing problems. Print a 
Nozzle Check Pattern and check the printed patterns.

 Printing a Nozzle Check Pattern
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Printout Is Unsatisfactory

CHECK 2 PRINTER DRIVER SETTINGS CORRECT FOR MEDIA AND PRINT JOB?

Open the printer driver dialog box and select the print mode best suited for 
the print job.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Selecting the BJ Cartridge and Media Type

You may also want to click the Advanced button 
in the Main tab. Click the Color tab, check that 
Color Adjustment is enabled and then adjust the 
color settings such as Color Balance, Output Style, 
and Brightness.

 Changing the Print Dialog Box Settings

Select the Color panel and change the settings 
such as the Matching method.

Windows

Macintosh
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Printout Is Unsatisfactory

CHECK 3 RE-FILLED INK TANK INSTALLED IN THE BJ CARTRIDGE?

You may not be able to achieve satisfactory performance with an ink tank 
that has been re-filled or that uses third party ink. It is recommended that 
you use ink tanks specifically designed for use with the Canon BJ 
cartridge.

 Using BJ Cartridges
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Printout Is Unsatisfactory

�  Printed and On-screen Colors Do Not Match
The colors you see on the screen do not match the colors you see in the printed copy of the 
same image. For example, objects that appear blue on the screen are printed purple and 
objects that appear pale green on the screen are printed dark green.

A color display and printer do not reproduce color in the same way. The printed color tones 
may not perfectly match the colors you see on the screen because screen color varies 
depending on how the screen is viewed and calibrated.

When the differences between displayed and printed colors are too extreme, check the 
following.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If there are wide differences between the screen colors and printed colors, 
one of the ink tanks may have run out of ink or some of the print head 
nozzles may be clogged.

Print a Nozzle Check Pattern and check the results.

Clean the print head when the patterns are broken or missing.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head
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Printout Is Unsatisfactory

CHECK 2 ARE THE PRINTER DRIVER SETTINGS CORRECT?

Open the printer driver dialog box and select the print mode best suited for 
the print job in the Choose Print Mode box under the Main tab.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Selecting the Print Mode

You may also want to click the Advanced button in the 
Main tab, click the Color tab and adjust the color 
settings such as Color Balance, Output Style, and 
Brightness. If Color Adjustment is off, click the 
checkbox to turn it on.

 Changing the Print Dialog Box Settings

Use Manual for printing.

CHECK 3 ARE YOU USING PLAIN PAPER OR HIGH RESOLUTION PAPER?

The color clarity of your printouts will be different when using various print 
media. To obtain the best color results, use Canon High Resolution Paper 
or Canon Glossy Photo Paper.

Macintosh

Windows
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Printout Is Unsatisfactory

�  Printout Does Not Match the Document Displayed on the Screen
The document is displayed correctly on the screen but the printout does not match the 
screen.

CHECK 1 DID YOU CANCEL A PRINT JOB BEFORE IT WAS COMPLETED?

There may be data remaining in the printer or the computer from the 
previous print job. Unplug the printer and power down the computer, then 
plug the printer back in, restart the computer, and try printing again.

To check for print data remaining from a previous job, 
select Settings from the Start menu, then click Printers. 
Double-click the BJC-2100 icon. If you see one or more 
print jobs queued for printing, select Purge Print 
Documents from the Printer menu. For details, see your 
Windows documentation or online Help.

Windows
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Printout Is Unsatisfactory

CHECK 2 ARE YOU USING THE CORRECT PRINTER DRIVER? 

Meaningless characters and symbols may print if you have selected the 
wrong printer driver for the print job.

Start the print procedure again and make sure that “Canon BJC-2100” is 
displayed in the Name entry box of the Print dialog box.

If another driver is selected, click the down-arrow and select “Canon 
BJC-2100” from the pull-down list.

To avoid this problem, set the BJC-2100 as the default printer.

CHECK 3 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty 
or loose connection can result in a printout that does not match the 
document displayed on the screen.

Windows

Note
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Printout Is Unsatisfactory

CHECK 4 IS THE PROBLEM IN THE ORIGINAL FILE?

If the printout does not match the document displayed on the screen when 
you print a certain file, the cause of the problem may be in the file or the 
application program you are using. Rebuild the file and print it again.

If the rebuilt file prints correctly, the original file was probably faulty.

If the rebuilt file does not print correctly, contact the software application 
company.

 Before You Call for Help
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Printout Is Unsatisfactory

�  Printed Text Rotated 90 Degrees
The document text orientation is not correct and it is printed rotated 90 degrees.

CHECK 1 IS THE ORIENTATION SETTING CORRECT?

Select Portrait to print across the width of the page and select Landscape 
to print across the length of the page.

Open the printer driver dialog box and set the correct printing 
direction.

Check the button for Orientation in the Page Layout tab.

Select Page Setup from the File menu and check 
Orientation.

CHECK 2 IS LANDSCAPE ORIENTATION SPECIFIED IN THE APPLICATION 
PROGRAM?

Check the Orientation feature in your application program.

Some application programs have a setting in the print dialog box that 
allows you to set the orientation.

For details, refer to the documentation of the application program.

If the application program has an Orientation setting, make sure that the 
setting (Portrait/Landscape) matches the Orientation setting in the printer 
driver.

Note

Macintosh

Windows
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Printout Is Unsatisfactory

�  Printing in Top Left Corner
CHECK 1 IS THE PAPER IN THE PRINTER LARGER THAN THE PAGE SIZE 

SPECIFIED IN THE PRINTER DRIVER?

If you print on paper larger than the page size selected in the printer 
driver, the page is printed in the top left corner.

Open the printer driver dialog box and check the page size setting. If the 
setting does not match, replace the paper in the printer or change the 
page size setting.

 Setting the Page Size

 Changing the Page Setup Dialog Box Settings

CHECK 2 IS SCALED PRINTING SET FOR REDUCTION IN THE PRINTER DRIVER?

If Scaled Printing is set for reduction in the printer driver, the document is 
reduced and printed in the top left corner of the page.

To disable Scaled Printing, open the Printer Properties dialog box for 
Windows or the Page Setup dialog box for Macintosh and change the 
setting.

 Opening the Printer Properties Dialog Box

 Changing the Page Setup Dialog Box Settings

Macintosh

Windows

Macintosh

Windows
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Printout Is Unsatisfactory

If you want to use Scaled Printing with reduction, make sure that the 
correct percentage is set and confirm that the page size selection is 
correct.

Refer to the printer driver online help for more details.

�  Text Cut Off at Bottom Right Corner, Right Edge, or Bottom Edge
The text is printing in the bottom right corner of the page or printing beyond the right or 
bottom margins and cut off from view.

CHECK 1 IS THE PAPER IN THE PRINTER SMALLER THAN THE PAGE SIZE 
SPECIFIED IN THE PRINTER DRIVER?

If you print on paper smaller than the page size selected in the printer 
driver, text is printed in the bottom right corner, or cut off at the bottom or 
right edge of the paper.

Open the printer driver dialog box and check the page size setting.

If the setting does not match the size of the paper in the printer, replace 
the paper in the printer or change the page size setting.

 Setting the Page Size

 Changing the Page Setup Dialog Box Settings Macintosh

Windows
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Printout Is Unsatisfactory

CHECK 2 IS SCALED PRINTING SET FOR ENLARGEMENT IN THE PRINTER 
DRIVER?

If Scaled Printing is set for enlargement in the printer driver, the document 
is enlarged and printed in the bottom right corner, or cut off at the bottom or 
right edge of the paper.

To disable Scaled Printing, open the Printer Properties dialog box for 
Windows or the Page Setup dialog box for Macintosh and change the 
setting.

Refer to the printer driver online help for more details.

 Opening the Printer Properties Dialog Box

 Changing the Page Setup Dialog Box SettingsMacintosh

Windows
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Printout Is Unsatisfactory

�  Text or Image Reversed (Mirrored)
The printed image is printed with left and right sides reversed or “mirrored”.

CHECK IS BACK PRINT FILM OR T-SHIRT TRANSFER SELECTED FOR MEDIA 
TYPE?

Open the printer driver dialog box and check the Media Type setting. If the 
setting is not correct, click the down-arrow and select the correct media 
from the pull-down list.

The Media Type setting must match the media loaded in the printer for the 
print job.

 Selecting the Print Mode

 Changing the Print Dialog Box SettingsMacintosh

Windows
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Printout Is Unsatisfactory

�  Enlarged/Reduced Printing Not Correct
A print job set up for Scaled Printing in the printer driver is not executing correctly.

CHECK 1 DOES THE SIZE OF THE PAPER IN THE PRINTER MATCH 
THE PAGE SIZE SETTING IN THE PRINTER DRIVER?

If you are using Scaled Printing to enlarge or reduce the print job so it fits 
on the paper in the printer, first set the Page Size in the Page Layout tab to 
the size specified in the application program. Next, set the Printer Page 
Size to the size of the paper in the printer.

CHECK 2 ARE YOU USING THE CORRECT PAPER SIZE FOR SCALED PRINTING?

To set the scale for the enlargement or reduction, load paper that matches 
the printer page size setting.

Refer to the printer driver online help for more details.

WindowsWindows
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Printout Is Unsatisfactory

�  Single Page Prints Over Two or More Pages

CHECK 1 DOES THE PAGE SIZE SETTING IN THE APPLICATION 
PROGRAM AND PRINTER DRIVER MATCH?

Set the same Page Size setting for the application program and the printer 
driver.

Open the Printer Properties dialog box, click the Page Layout tab, and 
select the Page Size that matches the Page Size setting in the application 
program.

 Setting the Page Size

CHECK 2 IS THE SIZE OF THE TOP MARGIN SPECIFIED IN THE APPLICATION 
PROGRAM TOO LARGE?

In the application program, set the top, bottom, right or left margin to the 
minimum values. If you cannot change the margin, increase the number of 
lines per page.

For more information about setting the page format in the application 
program, refer to the documentation of your application program.

Windows

Note
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Printout Is Unsatisfactory

�  Colors Streaked or Incorrect
The text appears scratched, streaked, or the wrong colors are printed.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If text or images are streaked, scratched, faint, or if the wrong colors are 
printing, one of the ink tanks may have run out of ink, the print nozzles 
may be clogged, or the print head may be worn out.

Print a Nozzle Check Pattern and check the printed patterns.

Clean the print head when the patterns are broken or missing.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

CHECK 2 HAS THE PROTECTIVE TAPE OR CAP BEEN REATTACHED?

After removing the orange protective cap and tape, do not attempt to 
re-attach them to the BJ cartridge. Re-attaching the tape or cap can cause 
air bubbles or trap dirt or dust and clog the ink nozzles.

If the protective tape or cap has been re-attached, remove it. Install the BJ 
cartridge in the printer and clean the print head immediately.

After cleaning the print head, if printing is patchy or streaked replace the 
BJ cartridge.

Macintosh

Windows
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Printout Is Unsatisfactory

CHECK 3 DID YOU PRINT ON THE CORRECT PRINT SIDE OF THE MEDIA?

The correct print side is different for each type of media.

Make sure that the correct print side is facing up when you load the media 
in the auto sheet feeder.

 Notes on Handling Print Media

�  Straight Lines Are Broken

CHECK 1 IS THE BJ CARTRIDGE INSTALLED CORRECTLY?

Remove the BJ cartridge and re-install it correctly.

 Replacing the BJ Cartridge

CHECK 2 IS PRINT QUALITY SET TO FAST IN THE PRINTER DRIVER?

Changing Print Quality to Fine in the printer driver may improve the quality 
of printed straight lines. 

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right to select Fine.

Windows
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Printout Is Unsatisfactory

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Quality panel, drag the slide bar to the right to select Fine.

�  Printed Pages Curled
As printed pages are ejected from the printer, they are curled or wavy.

CHECK 1 ARE YOU PRINTING ON THIN PAPER?

The large amount of ink used to print color photographs and illustrations 
can cause printed pages to curl or warp.

For such cases, be sure to use special media such as High Resolution 
Paper or Glossy Photo Paper.

When you use High Resolution Paper, Glossy Photo Paper, or other 
special media, always load the pages with the print side facing up. Only 
one side of these media is treated with a special coating for better ink 
absorption.

Note

Macintosh
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Printout Is Unsatisfactory

CHECK 2 IS THE PRINTER DRIVER SET FOR HIGH DENSITY PRINTING?

Move the Intensity setting (print density) to a lower setting and execute the 
print job again. A lower intensity setting uses less ink thus preventing 
curling of the printed page. 

1 Open the Printer Properties dialog box and click the Advanced 
button in the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the Intensity setting.

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 Click the Color panel, and use the Intensity slide bar to change the 
intensity setting.

Curling occurs most frequently with small paper sizes such as A5. To 
avoid this curling problem, try not to use small paper sizes to print 
documents that contain photographs or illustrations.

Note

Macintosh

Windows
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Printout Is Unsatisfactory

�  Backs of Pages Stained With Ink
The backs of pages are stained after they are printed and ejected from the printer.

CHECK 1 IS THE INSIDE OF THE PRINTER DIRTY?

Clean the printer periodically. Printouts may be stained by excess ink 
inside of the printer.

 Cleaning the Printer

CHECK 2 IS A PAGE EJECTED BEFORE THE PREVIOUS PAGE IS DRY?

If you are printing on media that requires a few minutes to dry, remove 
each page from the paper output tray as it is ejected from the printer. This 
prevents the next page from stacking on top of a printed page before it is 
dry.
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Printout Is Unsatisfactory

�  Ink Blurred
Images are not sharp or the ink has spread and run together.

CHECK 1 ARE YOU PRINTING A PHOTOGRAPH OR ILLUSTRATION THAT 
REQUIRES A LARGE AMOUNT OF INK?

In the printer driver, set Print Quality to Fine. The Fine setting reduces the 
tendency for ink to spread in printing color documents that require large 
amounts of ink, and reduces the tendency for ink to spread where black 
areas are adjacent to colored areas.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right toward the Fine 
setting.

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Quality panel, drag the slide bar to the right toward the Fine 
setting.

Macintosh

Windows
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Printout Is Unsatisfactory

CHECK 2 ARE YOU USING PLAIN PAPER?

If you are using plain paper, use another type of print media. To minimize 
ink spread, use High Resolution Paper, Glossy Photo Paper, or High 
Gloss Film.

CHECK 3 IS THE PRINT HEAD DIRTY?

Clogged print head nozzles can cause ink spread and blurring, so clean 
the print head.

 Cleaning the Print Head

CHECK 4 IS THE PRINTER DRIVER SET FOR HIGH DENSITY PRINTING?

The Intensity setting in the printer driver can be used to adjust print 
density (that is, the amount of ink used to print). Lowering the print density 
setting can reduce the tendency for ink to spread in color photographs or 
illustrations.

1 Open the Printer Properties dialog box and click the Advanced 
button in the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the intensity setting.

Windows
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Printout Is Unsatisfactory

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Color panel, use the Intensity slide bar to change the print 
density setting.

�  Printed Surface Scratched
The print side of the paper is scratched.

CHECK 1 ARE YOU PRINTING ON THICK PAPER?

If you print on paper thicker than the allowed maximum weight of 28 lb 
(105 g/m2), the print head may scratch the printed surface of the page. If 
you experience difficulty when printing on thick paper, clean the print 
head.

 Cleaning the Print Head

CHECK 2 IS THE PAPER THICKNESS LEVER SET CORRECTLY?

When printing on thick paper such as envelopes or banner paper, move 
the paper thickness lever all the way to the right.

Also, try moving the paper thickness lever to the right if the printer surface 
is scratched when printing on plain paper.

Macintosh
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Printout Is Unsatisfactory

CHECK 3 ARE YOU PRINTING ON CURLED PLAIN PAPER?

If curled plain paper is loaded with the curl bowing up, the print head may 
scratch the bottom edge of the paper.

Remove the plain paper, turn it over, and load it in the auto sheet feeder 
again.

CHECK 4 ARE YOU EXECUTING A HIGH DENSITY PRINT ON PLAIN PAPER?

If you execute a high density print job on plain paper, the paper may 
absorb too much ink and curl, and the print head may scratch the surface 
of the curled page. Lower the Intensity setting.

1 Open the Printer Properties dialog box, and click the Advanced 
button in the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the color density setting.

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Color panel, use the Intensity slide bar to change the print 
density setting.

Macintosh

Windows

Download from Www.Somanuals.com. All Manuals Search And Download.



179Troubleshooting

Printout Is Unsatisfactory

CHECK 5 ARE YOU PRINTING OUTSIDE THE RECOMMENDED PRINTING AREA?

If you print outside the recommended printing area, the print head may 
scratch the bottom edge of the page.

To avoid problems, print only in the recommended printing area.

 Printing Area

�  White Streaks Visible

CHECK PRINT A NOZZLE CHECK PATTERN.

If colors are broken or missing, clean the print head.

If any portion of the Nozzle Check Pattern is streaked, the print head 
could be clogged or the BJ cartridge may be worn out.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

 Replacing the BJ Cartridge

If the Nozzle Check Pattern prints normally, there may be a problem in the 
application program. For details, refer to the documentation of your 
application program.

Note
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Printout Is Unsatisfactory

�  Colors Streaked or Uneven

Patterns of uneven or streaked coloring appear on the printout.

CHECK 1 IS PRINT QUALITY ON THE QUALITY TAB IN THE PRINTER DRIVER SET 
TO FAST?

Set Print Quality to Fine and print again. This reduces uneven coloration 
you may see in a document where a large amount of ink is used.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right toward Fine and 
click the OK button.

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Quality panel, drag the slide bar to the right toward Fine.

Macintosh

Windows
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Printout Is Unsatisfactory

CHECK 2 IS HALFTONING SET FOR OPTIMUM PERFORMANCE?

Check the Halftoning setting in the Quality tab of the printer driver. The 
Diffusion setting smoothes uneven or streaked colors.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Halftoning box under the Quality tab, disable Auto if it is 
checked and enabled.

4 Click Diffusion and click the OK button.

1 When using Manual for printing, click the Details button in the Print 
dialog box.

2 In the Quality panel, set Halftoning to Scatter.

Macintosh

Windows
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Printout Is Unsatisfactory

�  Last Part of Print Job Not Printing
The last part of each page in the document is not printed.

CHECK 1 ARE YOU USING THE PAPER SIZE SPECIFIED IN THE PAGE SIZE 
SETTING?

If the size of the paper loaded in the printer does not match the page size 
setting in the printer driver, part of each page may not print.

Open the printer driver dialog box and adjust the setting.

 Setting the Page Size

 Changing the Page Setup Dialog Box Settings

Set the same page size setting for the application program and the printer 
driver.

CHECK 2 ARE THE COMPUTER AND PRINTER SECURELY CONNECTED?

Check the connection of the printer cable at the computer and printer. 
A loose connection can cause losing part of a print job.

Note

Macintosh

Windows
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Printout Is Unsatisfactory

CHECK 3 IS A WPS DRIVER INSTALLED?  

You may not be able to print correctly with a WPS (Windows Printing 
System) driver installed in your system. Confirm whether or not a WPS 
driver is installed in your system.

Change the WPS driver port setting to FILE or delete the WPS driver.

1 Open the WPS Driver Properties window.

2 In the Details tab, select FILE in the “Print to the following port” 
setting.

3 To delete the WPS driver, select Programs and then Windows 
Printing System from the Windows Start menu and click Uninstall.

Windows
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Printout Is Unsatisfactory

�  Characters and Figures Notched / Gradation Streaked
    or Unnatural
Characters and figures print with unnatural notches. Gradation appears streaked.

CHECK ARE YOU USING AN APPLICATION PROGRAM THAT ONLY SUPPORTS 
POSTSCRIPT?

The BJC-2100 is a QuickDraw printer and is not a PostScript printer. 
Therefore, if you use an application program that only supports PostScript, 
the lines of characters and figures may print with unnatural notches. 
Always use an application program that supports QuickDraw.

Some PostScript application programs have a setting that allows you to 
use ATM fonts or TrueType fonts. When you specify the ATM fonts or 
TrueType fonts in an application program, characters, figures and 
gradation can be reproduced properly.

Macintosh
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Printout Is Unsatisfactory

�  Color Document Not Satisfactory

CHECK 1 ARE THE COLOR ADJUSTMENT SETTINGS CORRECT?

In the printer driver, you can adjust the color tones of the image by 
changing the density of each color (cyan, magenta, yellow and black). For 
example, you can lower the magenta setting when the reds are too dark or 
raise the cyan setting when the blues are too light.

1 Open the Printer Properties dialog box, and click the Advanced button 
in the Main tab.

2 Click the Color tab.

3 Move the slide bars of the individual colors to the left or right (or click 
the arrows on each end of the slide bars).

If Color Adjustment is grayed out and cannot be used, check Color 
Adjustment in the checkbox. For Windows 98, confirm that Use ICM is not 
checked.

Note

Windows
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Printout Is Unsatisfactory

1 When using Manual for Printing, click the Details button.

2 Click the Color panel.

3 Move the slide bars of the individual colors to the left or right.

CHECK 2 IS THE BRIGHTNESS ADJUSTED CORRECTLY?

In the printer driver, you can specify the contrast among intermediate 
tones between black and white. For example, adjusting the brightness 
toward Light makes the overall image brighter, with stronger contrast in 
the light areas and lower contrast in the dark areas.

Brightness is also referred to as the gamma curve coefficient.

1 Open the Printer Properties dialog box, and click the Advanced button 
in the Main tab.

2 Click the Color tab.

3 Specify the desired brightness setting in the Brightness box.

If Brightness is grayed out and cannot be used, check Color Adjustment in 
the checkbox. For Windows 98, confirm that Use ICM is not checked.

Note

Note

Macintosh

Windows
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Printout Is Unsatisfactory

1 When using Manual for printing, click the Details button.

2 Select the Color panel.

3 Specify the desired brightness setting.

If Brightness is grayed out and cannot be used, check Brightness in the 
checkbox.

CHECK 3 ARE THE OUTPUT STYLE SETTINGS CORRECT?

The Output Style settings in the printer driver allow you to specify whether 
intermediate tones are emphasized in the printout or primary colors are 
printed more brightly.

Auto: Samples the data stream and selects the optimum 
(Windows) matching method for the print job.

Accurate or Emphasizes intermediate tones. Best suited for natural
Photo: images (skin tone, sky blue, foliage green, etc.).

Vivid or Graphic: Emphasizes primary colors. Reds, blues, yellows printed 
brightly for color graphs, charts, and tables.

Spot Color: Emphasizes basic colors. Best suited for documents 
(Macintosh) that require few intermediate colors. 

Note

Macintosh
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Printout Is Unsatisfactory

1 Open the Printer Properties dialog box, and click the Advanced button 
in the Main tab.

2 Click the Color tab.

3 Select Auto, Accurate, or Vivid in the Output Style box.

If Output Style is grayed out and cannot be used, check Color Adjustment 
in the checkbox. For Windows 98, confirm that Use ICM is not checked.

1 When using Manual for printing, click the Details button.

2 Select the Color panel.

3 Specify the Matching Method setting.

If Output Style is grayed out and cannot be used, check Matching Method 
in the checkbox.

Note

Note

Macintosh

Windows
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Printer Does Not Start or Stops Mid-job

Printer Does Not Operate After It Is Plugged In

Print Job Does Not Start

Printing Halts

Printing Starts But Nothing Prints

Cartridge Holder Does Not Move to Center

Cartridge Holder Does Not Return to Home Position

Checking the Printer and Computer Connection

Setting the BJC-2100 as the Default Printer
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Printer Does Not Start or Stops Mid-job

�  Printer Does Not Operate After It Is Plugged In
The printer does not operate after its power cord is plugged into a power outlet.

CHECK 1 IS THE PRINTER PLUGGED IN?

There is no power button on this printer. The printer is turned on 
automatically as soon as it is plugged into the power outlet.

Confirm that printer power plug is connected to the printer and plugged 
into a live power outlet.

CHECK 2 IS THE POWER OUTLET LIVE?

Connect another electrical device to the same power outlet. If the other 
device operates normally, the power outlet is functioning normally.

If you perform these checks and the problem is not solved, unplug the 
printer and contact the Canon Customer Care Center.

 Before You Call for Help

 Getting Help From Canon
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Printer Does Not Start or Stops Mid-job

�  Print Job Does Not Start
Printer does not operate after the print job is executed from the computer.

CHECK 1 IS THE PRINTER TURNED ON?

There is no power button on the printer. The printer turns on automatically 
as soon as you plug it into the power outlet.

 Printer Does Not Operate After It Is Plugged In

CHECK 2 ARE YOU PRINTING A VERY LARGE FILE?

A very large file may require some time to process before printing begins. 
Photographs and illustrations can increase the size of a file. For a very 
large file, wait a few minutes for the print job to begin.

CHECK 3 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty 
or loose connection can prevent it from starting.

 Checking the Printer and Computer Connection
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Printer Does Not Start or Stops Mid-job

CHECK 4 ARE YOU USING THE CORRECT PRINTER DRIVER?

A print job may not start if you have selected the wrong printer driver for 
the print job.

Check that “Canon BJC-2100” is displayed in the Name entry box of the 
Print dialog box. If another driver is selected, click the down-arrow and 
select “Canon BJC-2100” from the pull-down list. If BJC-2100 does not 
appear in the list, you must install the printer driver.

If you use only the BJC-2100, select the BJC-2100 as the default printer.

Select BJC-2100 from the Chooser in the Apple menu.

 Setting the BJC-2100 as the Default Printer

Note

Windows

Macintosh
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Printer Does Not Start or Stops Mid-job

CHECK 5 IS THE CORRECT PRINTER PORT SELECTED?  

If you are using the Parallel interface to connect your printer, set your 
printer port to LPT1.

If you are using the USB Interface to connect your printer, set your printer 
port to USBPRNnn.

1 Open the Printer Properties dialog box directly from the Start menu.

2 Click the Details tab and select LPT1 or USBPRNnn in the Print to the 
following port box (LPT1: Canon BJ LPT Printer Port).

 Opening the Printer Properties Dialog Box

Windows
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Printer Does Not Start or Stops Mid-job

�  Printing Halts
The printer stops printing before the print job is complete.

CHECK 1 IS THE PRINT JOB A FINELY DETAILED PHOTOGRAPH OR 
ILLUSTRATION?

The printer requires more time to process a finely detailed illustration or 
photograph.

If the print job requires using a large amount of black ink on plain paper, 
the print job may require more time.

CHECK 2 HAS THE PRINTER BEEN OPERATING FOR A LONG TIME?

The print head may occasionally overheat during a long print job.

If the print head overheats, printing pauses at the end of a pass across the 
page to allow time for the print head to cool and then restarts after a brief 
interval. Interrupt printing at a convenient point, unplug the printer and 
wait for at least 15 minutes for the print head to cool.

To avoid minor burns, do not touch the print head or the surrounding area.Caution
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Printer Does Not Start or Stops Mid-job

�  Printing Starts But Nothing Prints
The printer operates but nothing is printed on the page.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

The print head nozzles may be clogged, one or more of the ink tanks may 
be low, or the BJ cartridge may be worn.

Print a Nozzle Check Pattern to check the status of the print head and 
clean the print head.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

If the problem is not solved, replace the ink tank or the BJ cartridge.

 Replacing Ink Tanks

 Replacing the BJ Cartridge

If the Nozzle Check Pattern looks correct, check that the printer is 
connected to the computer securely. If the connection is loose, printing will 
start but nothing may be printed.

Also check that there is not a problem with the original file.
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Printer Does Not Start or Stops Mid-job

CHECK 2 DID YOU REMOVE THE ORANGE PROTECTIVE TAPE FROM THE PRINT 
HEAD?

If the orange protective tape is not removed from the BJ cartridge, ink 
cannot be ejected from the BJ cartridge. Remove the BJ cartridge and 
check the print head. If the tape has not been removed, remove it. 

 Replacing the BJ Cartridge

�  Cartridge Holder Does Not Move to Center
You want to switch the BJ cartridge, replace an ink tank, or replace the BJ cartridge, but the 
cartridge holder does not move to the center when you open the front cover.

CHECK 1 IS THE PRINTER TURNED ON?

Confirm that the printer is plugged in.

CHECK 2 HAVE YOU BEEN PRINTING FOR AN EXTENDED PERIOD?

The print head overheats if you print continuously for long periods. When 
this happens, the cartridge holder stops moving to protect the print head. 
Wait about 15 minutes for the print head to cool.
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Printer Does Not Start or Stops Mid-job

�  Cartridge Holder Does Not Return to Home Position
When you replace a BJ cartridge or ink tank, the cartridge holder does not return to the 
home position after you close the front cover.

The cartridge holder normally stays at the right except during printing or 
when you open the front cover.

CHECK IS THE BJ CARTRIDGE CORRECTLY INSTALLED?

The cartridge holder will not return to the home position if the BJ cartridge 
is not correctly installed. Disconnect the power cord. Then reconnect the 
power cord and reinstall the BJ cartridge.

If the reinstalled cartridge holder still does not return to the starting 
position, install another BJ cartridge.

 Replacing the BJ Cartridge

If the problem still persists, there may be a fault in the printer. Contact the 
Canon Customer Care Center.

 Getting Help From Canon

Note
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Printer Does Not Start or Stops Mid-job

�  Checking the Printer and Computer Connection
If you have problems with the printer, the cause may be in the hardware you are using to 
connect the printer and computer.

• If you are using a switching device, USB hub or external buffer, 
disconnect the device and connect the printer directly to the computer 
again. If you can print normally with the direct connection, contact the 
manufacturer of the device.

• The printer cable may be faulty, or you may be using the wrong type of 
cable. Replace the printer cable and try again.

Recommended printer cable specifications are as follows:

When using the parallel interface
Material: AWG28 or larger
Type: Twisted-pair shielded cable
Length: Up to 2.0 m (6.5 ft)
Connectors: Amphenol 30360 or equivalent

When using the USB interface
Material: AWG28 (data wiring pair) or AWG20 to 28 

(distribution pair)
Type: Twisted-pair shielded cable
Length: Up to 5.0 m (16.4 ft)
Connectors: USB standard Series B pluggable
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Printer Does Not Start or Stops Mid-job

�  Setting the BJC-2100 as the Default Printer 
When you are using more than one printer, you may find it convenient to set the BJC-2100 
as the default printer.

1 On the Windows desktop, click the Start button, point to Settings, and 
click Printers.

2 When the Printer window opens, click the BJC-2100 icon to highlight 
it.

3 Select Set As Default from the File menu.

1 Select Chooser from the Apple menu.

2 Select BJC-2100.

Windows

Macintosh
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Paper Jams or Does Not Feed

Paper Does Not Feed From Auto Sheet Feeder

Envelopes Do Not Feed

Paper Skewing During Feeding

Multiple Sheets Feed Together

Paper Jam
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Paper Jams or Does Not Feed

�  Paper Does Not Feed From Auto Sheet Feeder
After the print job is started, the paper loaded in the auto sheet feeder does not feed.

CHECK 1 IS THE PAPER TOO THICK?

Thick paper does not feed. Do not attempt to print on paper or other media 
thicker than 28 lb (105 g/m2).

CHECK 2 IS THE SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

 Notes on Handling Print Media

CHECK 3 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, do not load paper in the auto sheet 
feeder that is folded, curled or wrinkled.

 Notes on Handling Print Media
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Paper Jams or Does Not Feed

CHECK 4 DID YOU REMOVE THE PAPER REST?

Make sure the paper rest is installed on the printer at all times.

CHECK 5 ARE YOU PRINTING TRANSPARENCIES OR BACK PRINT FILM?

If you are printing on transparencies or back print film, insert a sheet of 
plain paper (of the same size) in the auto sheet feeder behind the 
transparencies or film.
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Paper Jams or Does Not Feed

�  Envelopes Do Not Feed
Envelopes do not feed or skew during feeding.

CHECK 1 ARE THE ENVELOPES CURLED OR BENT?

Before you load envelopes, make sure they are flat. Press down firmly 
around the edges of the stack to flatten the envelopes and expel air from 
inside the envelopes.

If the envelopes are still not perfectly flat, hold the edges of the stack 
diagonally and bend them gently to straighten them.

Make sure that the flaps in the stack are straight and not overlapping.

If the envelopes still do not feed, use a pen or similar object to flatten the 
edges of the envelopes.

 Envelopes

Download from Www.Somanuals.com. All Manuals Search And Download.



204Troubleshooting

Paper Jams or Does Not Feed

CHECK 2 ARE TOO MANY ENVELOPES LOADED?

You can set up to 5 envelopes in the auto sheet feeder.

CHECK 3 IS THE PAPER GUIDE SET CORRECTLY?

If the paper guide on the auto sheet feeder is not set correctly, the paper 
does not feed straight or may jam in the printer.

The paper guide must be snug against the side of the stack and not too 
tight.

CHECK 4 ARE THE ENVELOPES LOADED CORRECTLY?

To avoid misfeeds and jams, always load the top edge of an envelope (or 
stack of envelopes) lengthwise with the flap side down.

 Envelopes
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Paper Jams or Does Not Feed

�  Paper Skewing During Feeding
The paper or other media does not feed straight into the paper feed slot.

CHECK 1 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

CHECK 2 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, do not load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Notes on Handling Print Media

CHECK 3 IS THE PAPER GUIDE SET CORRECTLY?

If the paper guide on the auto sheet feeder is not set correctly, the paper 
does not feed straight or may jam in the printer.

The paper guide must be snug against the side of the stack and not too 
tight.
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Paper Jams or Does Not Feed

�  Multiple Sheets Feed Together
When you have a stack of paper in the sheet feeder, more than one sheet feeds from the 
stack at the same time.

CHECK 1 DID YOU FAN THE STACK BEFORE LOADING?

Before loading a stack of media in the auto sheet feeder, always fan the 
pages to remove static cling and align the edges. Fanning the stack 
separates the sheets so they can feed smoothly from the auto sheet 
feeder.

CHECK 2 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

CHECK 3 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, do not load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Notes on Handling Print Media
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Paper Jams or Does Not Feed

�  Paper Jam
If paper jams in the printer, remove it.

1 Slowly pull the paper out of the printer from the auto sheet feeder or 
the paper output slot, whichever is easier. If the paper tears or shreds, 
unplug the printer, then open the front cover and remove all the 
fragments of paper.

2 Close the front cover, load the paper, and then print again.
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Paper Jams or Does Not Feed

• You can load paper within the range of 17 to 28 lb (64 to 105 g/m2) in the 
auto sheet feeder.

 Media Sizes

• To avoid misfeeds and paper jams, do not load wrinkled, folded, or curled
  paper in the auto sheet feeder.

 Notes on Handling Print Media

Note
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An Error Message Appears

Error Writing to LPT1 or USBPRNnn 

Application Error, General Protection Fault 

Other Error Messages

Windows

Windows
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An Error Message Appears

�  Error Writing to LPT1 or USBPRNnn  
You cannot print when this message appears.

CHECK 1 IS THE PRINTER PLUGGED IN?

Confirm that printer’s power plug is connected to the printer and plugged 
into a live power outlet. After the printer is plugged in, the printer turns on 
automatically. There is no power button on the printer.

 Printer Does Not Operate After It Is Plugged In

CHECK 2 ARE THE PRINTER AND COMPUTER CONNECTED PROPERLY?

Check the connections of the printer cable at the computer and the printer.

CHECK 3 IS PRINT SPOOLING OPERATING CORRECTLY?

Cancel spooling and send the print job directly to the printer. 

1 Open the Printer Properties dialog box from the Start menu.

2 Click the Details tab and click the Spool Settings button. Click the 
button for “Print directly to the printer”.

 Opening the Printer Properties Dialog Box

Windows
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An Error Message Appears

CHECK 4 IS THE PRINTER PORT OPERATING CORRECTLY? 

Check the status of the printer port.

When you are using the parallel interface:

1 Right-click the My Computer icon and select Properties from the 
pop-up menu.

2 Click the Device Manager tab.

3 Select Ports (COM & LPT), then double-click Canon BJ LPT Printer 
Port (LPT1).

4 In the General tab, check that Original Configuration (Current) is 
enabled. An error will occur if this item is disabled. Read the message 
under Device Status and verify that a problem is not indicated.

5 Click the Resources tab and read the message in the list under 
Conflicting device list. If a conflict is indicated, delete the competing 
device.
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An Error Message Appears

When you are using the USB interface:

1 Right-click the My Computer and then select Properties.

2 Double-click Universal serial bus controller on the Device manager 
tab, and then double-click CANON BJC-2100.

3 Note what is displayed on the General tab.

CHECK 5 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver. Uninstall the printer driver 
and install it again.
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An Error Message Appears

CHECK 6 IS THE PRINTER PORT SETTING IDENTICAL TO THE INTERFACE YOU 
ARE USING?

If the printer port setting is not identical to the interface connected to the 
printer, an error message appears.

To check the printer port setting, open the Printer Properties dialog box 
and click the Details tab.

• If LPT1 is displayed in the “Print to the following port” box, the printer 
port is set to the parallel port.

• If USBPRNnn (nn: numerals) is displayed in the “Print to the following 
port” box, the printer port is set to the USB port.

If the printer port setting does not match the printer’s interface connection 
type, shut down Windows and unplug the printer. Then connect the printer 
using the correct interface specified in the printer driver again, or install 
the correct printer driver that matches the connected interface again.
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An Error Message Appears

CHECK 7 IS A WPS DRIVER INSTALLED?

You may not be able to print correctly if a WPS (Windows Printing System) 
driver is installed in your computer.

1 Click Start, point to Settings, and click Printers.

2 If a WPS driver is installed, right-click the icon and then select 
Properties from the pop-up menu.

3 Click the Details tab and check the “Print to the following port” setting.

If the selected port is the port also used by the BJC-2100, change the 
WPS driver port setting to FILE or delete the WPS driver.
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An Error Message Appears

�  Application Error, General Protection Fault  
CHECK 1 ARE YOU USING A WINDOWS 3.1 APPLICATION PROGRAM?

Attempting to print from a Windows 3.1 application program installed on 
the Windows 98 or Windows 95 platform may cause an error. Use a 
Windows 98 or Windows 95 compatible application program.

CHECK 2 ARE SEVERAL APPLICATION PROGRAMS RUNNING IN THE 
BACKGROUND?

If you are running several application programs at the same time, there 
may not be enough memory available for the print job.

Quit the other application programs and try again.

CHECK 3 DOES THE COMPUTER HAVE SUFFICIENT MEMORY?

Make sure that you have the required amount of memory installed for the 
application program you are using to print.

For details, refer to the User’s Manual for your application program.

If the amount of memory is insufficient, install more memory.

 Checking the Printing Environment

Windows
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An Error Message Appears

CHECK 4 IS THERE SUFFICIENT FREE SPACE ON THE HARD DISK?

An error may occur if there is not enough free space available on the hard 
disk.

Check the amount of free space on the hard disk.

If there is little free space available on the disk, delete any unneeded files.

 Checking the Printing Environment

CHECK 5 IS THERE A PROBLEM IN THE FILE YOU ARE TRYING TO PRINT?

If one of these errors occurs only when you try to print a particular file, 
there may be a problem in the file or the application program. Rebuild the 
file and try printing it again.

If there is not a problem with the new file, the old file was probably faulty. 
If the same error occurs with the new file, call the Canon Customer Care 
Center.

 Before You Call for Help

 Getting Help From Canon
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An Error Message Appears

CHECK 6 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver.

Uninstall the printer driver and install it again.

�  Other Error Messages
CHECK 1 AN ERROR DISPLAYED IN THE BJ STATUS MONITOR?  

When an error occurs, the BJ Status Monitor screen opens.

The Print Status tab displays a short description of the error and other 
information about the print job. Click the Guide tab to display instructions 
on how to solve the problem.

For problems that require more than one step in correcting the problem, 
click the Next button to see the next screen, or click the Back button to see 
the previous screen.

Windows
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An Error Message Appears

CHECK 2 AN ERROR DISPLAYED IN ANY SCREENS OTHER THAN 
THE BJ STATUS MONITOR?

One of the following messages may be displayed.

Delete any unneeded files to make more disk space available.

Checking the Printing Environment

Quit any other application programs you are running in the background.

Checking the Printing Environment

Uninstall the printer driver and reinstall it.

Restart Windows and try again.

Try printing again after the current job is finished.

Could not spool successfully due to insufficient disk space

Could not spool successfully due to insufficient memory

Printer driver could not be found

Background printing failed

Could not print [application name]-[file name] 
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An Error Message Appears

CHECK 3 ANY ERROR NUMBER (XXXX:) DISPLAYED?  

Error number (*202) displayed

Sufficient memory not available for the application program. 

Check that the required amount of memory is allocated to the application 
program. 

If there is not enough memory installed, install more memory. 

Refer to the User’s Manual for your computer for information on installing 
additional memory.

Error number (*203) displayed

Installed printer driver not operating correctly. 

Remove the installed BJ printer driver and then install the printer driver 
again. 

Macintosh
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An Error Message Appears

Error number (*300) displayed

Check the following:

•  Printer is plugged in?

•  Printer cable is connected securely?

Make sure that the printer cable is securely fastened to the 
computer and the printer.

If the problem cannot be solved, check the settings in Chooser. 

1 Select Chooser from the Apple menu.

2 Click the BJC-2100 icon.

3 Make sure that BJC-2100 is specified in the Connect to box.

If the problem still cannot be solved, remove unneeded documents from 
Control Panels folder, and try again.
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Other Problems

Cannot Install Printer Driver

BJ Status Monitor Does Not Open 

Cannot Execute Background Printing

Ink Runs Out Too Quickly
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Other Problems

�  Cannot Install Printer Driver
CHECK 1 DID YOU FOLLOW THE PRINTER DRIVER INSTALLATION INSTRUCTIONS 

IN THE QUICK START GUIDE?

The Quick Start Guide provides step-by-step instructions for installing the 
printer driver. If you are re-installing the printer driver, remove any other 
Bubble Jet printer drivers that have been installed on the computer before 
re-installing the printer driver.

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the printer driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the printer driver.

Note
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Other Problems

CHECK 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The installation program may not execute successfully if it is started with 
other applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

If other BJ printer drivers are installed in your system, uninstall them 
before you run the installation program again.

CHECK 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION? 

If the driver installation program did not start automatically when you 
loaded the CD-ROM, double-click the My Computer icon, then double-
click the CD-ROM icon on the Windows desktop.

For details about the installation procedure, refer to the Quick Start Guide.

• The drive name (E: for example) varies according to how your system is 
   set up.

•  When you install the printer driver from Run in the Start menu, correctly 
   specify the CD-ROM drive and file name of the printer driver installation 
   program (Setup.exe).

Windows

Note
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Other Problems

CHECK 4 IS THERE A PROBLEM WITH THE INSTALL ME FIRST CD-ROM?

The Install Me First CD-ROM may be damaged. On the Windows desktop, 
double-click the My Computer icon then double-click the CD-ROM icon. 
If Windows cannot read the CD-ROM, call the Canon Customer Care 
Center.

 Before You Call for Help

 Getting Help From Canon
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Other Problems

�  BJ Status Monitor Does Not Open  
CHECK 1 DO YOUR COMPUTER AND PRINTER CABLE SUPPORT BI-DIRECTIONAL 

COMMUNICATION?

Check the hardware specifications for your computer and printer cable. 
Operation of the BJ Status Monitor depends on bi-directional data transfer 
between the computer and printer. The computer and printer cable must 
both be capable of sustaining bi-directional data transfer.

If you are unsure as to whether your computer or printer cable supports 
bi-directional communication, contact your hardware manufacturer.

CHECK 2 IS THE BI-DIRECTIONAL OPTION SELECTED IN THE PRINTER DRIVER?

Check the bi-directional option.

1 Open the Printer Properties dialog box from the Start menu.

2 Click the Details tab and click the Spool Settings button.

3 In the Spool Settings dialog box, click the button for “Enable 
bi-directional support for this printer.”

 Opening the Printer Properties Dialog Box

Windows

Note
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Other Problems

�  Cannot Execute Background Printing
The BJ Backgrounder is not displayed during a print job and you cannot use background 
printing.

CHECK 1 IS THERE ENOUGH FREE SPACE AVAILABLE ON THE HARD DISK?

You may not be able to print if there is not enough free space on the hard 
disk. Delete unneeded files to create more space.

If you are unable to make more space available on your hard disk by 
deleting files, turn background printing off.

 Checking the Printing Environment

CHECK 2 IS BACKGROUND PRINTING ENABLED IN THE PRINTER DRIVER?

1 Open the Printer Properties dialog box, then click the Page Layout 
tab.

2 Check Background Printing in the Background checkbox.

1 Select Chooser from the Apple menu.

2 Set Backgrounding to On.

Note

Windows

Macintosh
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Other Problems

�  Ink Runs Out Too Quickly
CHECK ARE YOU OPENING AND CLOSING THE FRONT COVER?

Each time you open the front cover for more than a few seconds, print 
head cleaning starts and ink is consumed. Although this automatic 
mechanism is employed to ensure optimum print head performance, to 
conserve ink you want to avoid opening the front cover unnecessarily.

Print head cleaning also starts automatically whenever you replace a BJ 
cartridge.

Note
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Before You Call for Help

Narrowing Down the Problem

Checking the Printing Environment
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Before You Call for Help

�  Narrowing Down the Problem
If you are experiencing difficulties, try to narrow the problem down to one of these three 
factors:

• Printer problem
If the printer does not operate and you cannot resolve the problem, make a 
note of the nature of the fault and your observations then contact the Canon 
Customer Care Center.

 Getting Help From Canon

• Hardware problem other than the printer
If the printer is operating normally and the settings in the application program 
are also correct, there may be a problem with a printer cable or in the computer 
system (for example, memory, hard disk, interface). Contact your computer 
manufacturer.

• Application program problem
Problems that arise only when you use a particular application program are 
probably caused by the application program. For details, consult your software 
company.

The problem may also be solved by installing the latest version of the printer 
driver.
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Before You Call for Help

�  Checking the Printing Environment
Check the information on the operating environment such as the name and version number 
of your operating system, the amount of memory installed, hard disk capacity and amount 
of free space on hard disk, and the printer driver version number.

• Checking the Windows version and memory capacity
\

1 Right-click the My Computer icon and select Properties from the pop-
up menu.

2 On the General tab note the system name, version number, and 
memory capacity.

Select “About This Computer” from the Apple menu.

• Checking the amount of free space on the hard disk

1 On the Windows desktop, double-click the My Computer icon.

2 Right-click the icon of the hard disk and select Properties from the 
pop-up menu.

3 On the General tab, check the hard disk capacity and the amount of 
free space.

Windows

Macintosh

Windows
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Before You Call for Help

1 On the desktop, click the icon of the hard disk.

2 Select Get Info from the File menu.

3 Select General Information.

• Checking the version number of the printer driver

1 On the Windows desktop, click the Start button, select Settings, and 
click Printers.

2 Right-click the BJC-2100 icon and select Properties from the pop-up 
menu.

3 Click the Main tab and click the About button. The printer driver 
version is displayed.

1 Double-click the Extensions Folder in the System Folder and then 
select the BJC-2100 icon.

2 Select Get Info from the File menu.

3 Select General Information.

4 Check Version.

Macintosh

Macintosh

Windows
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Getting Help From Canon

Canon Computer Systems, Inc. offers a full range of customer technical support* options:

• For e-mail technical support, the latest driver downloads and answers to 
frequently asked questions (www.ccsi.canon.com)

• 24-hour, 7-day-a-week automated support for troubleshooting issues on most 
current products (1-800-423-2366)

• 24-hour, Fax-On-Demand System for product specifications and technical 
information (1-800-526-4345)

• Free technical support Monday–Saturday for products still under warranty ** 
(1-757-413-2848)

• Technical support 7 days a week for products no longer under warranty, for 
$24.99 per call (1-800-423-2366), or for $2.50 per minute, to a maximum of 
$25.00 per call (1-900-246-1200)

Within Canada, call for technical support 24 hours a day, 7 days a week
(1-800-OK-CANON)

* Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.

Note

Download from Www.Somanuals.com. All Manuals Search And Download.



233Specifications

Specifications

Printing Specifications

Printing Area
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Printing Specifications

Printing method
Bubble Jet on-demand

Printing resolution
720 (horizontal) × 360 (vertical) dpi

Print speed (printing with Canon standard pattern):

Black printing using BC-20 Black BJ Cartridge
Fast: 5 ppm
Normal: 4 ppm 

Color printing using BC-21e Color BJ Cartridge
Fast: 2 ppm

(*2.5 ppm)
Normal: 1.5 ppm

* Measured at ISO 10561

Print direction
Bi-directional

Print width
Max. 8.0 in (203.2 mm)
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Printing Specifications

�  Interface Specifications

Interface (parallel)
IEEE 1284-compatible

Interface (USB)
USB 1.10-compatible 

Interface connector (parallel)
Amphenol 57-40360 or equivalent

Interface connector (USB)
USB standard Series B receptacle (USB interface)

Recommended printer cable (parallel)
Material: AWG28 or larger
Type: Twisted-pair shielded cable
Length: Up to 6.5 ft (2.0 m)
Connectors: Amphenol 30360 or equivalent

Recommended printer cable (USB)
Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type: Twisted-pair shielded cable
Length: Up to 16.4 ft (5.0 m)
Connectors: USB standard Series B pluggable
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Printing Specifications

�  General Specifications

Acoustic noise level
Approx. 45 dB (per ISO 9296)

Operating environment
Temperature: 41 to 95˚F (5 to 35˚C)
Humidity: 10 to 90%RH (no condensation)

Storage environment
Temperature: 32 to 95˚F (0 to 35˚C)
Humidity: 5 to 90% RH (no condensation)

Power supply
USA/Canada AC 120 V, 60 Hz

Power consumption
Standby: Approx. 2 W 
Printing: Approx. 18 W

Dimensions (with paper rest and paper output tray and extension retracted):
14.6 × 7.5 × 6.5 in (W×D×H)
370 × 191 × 164 mm (W×D×H)

Weight
Approx. 5.3 lb (2.4 kg)
(with paper rest and paper output tray and extension attached)
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Printing Specifications

�  Feed Method

Continuous feed through auto sheet feeder; single or multiple sheets

�  Sheet Feeder Capacity
Plain Paper (20 lb) 50 sheets max.
Artist Canvas 1 sheet
Back Print Film 10 sheets max.
Banner Paper 1 sheet
Glossy Photo Cards 1 sheet
Glossy Photo Paper 1 sheet
Greeting Cards 1 sheet
High Gloss Film 1 sheet
High Resolution Paper 40 sheets max.
Magnet Sheet 1 sheet
Transparencies 20 sheets max.
T-shirt Transfers 1 sheet
Envelopes 5 pieces max.
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Printing Specifications

�  Print Media

Regular size Letter, Legal, A4, A5, B5, US Com.#10, European DL

Custom size Width: 3.94 to 9.5 in (100.0 to 241.3 mm)
Height: 3.94 to 23.0 in (100.0 to 584. 2 mm)

Weight 17 to 28 lb (64 to 105 g/m2)

Canon Speciality Papers
Artist Canvas
Back Print Film
Banner Paper
Brilliant White Paper
Bubble Jet Paper
Glossy Photo Cards
Glossy Photo Paper
Greeting Cards
High Gloss Film
High Resolution Paper
Magnet Sheet
Transparencies
T-Shirt Transfers

Download from Www.Somanuals.com. All Manuals Search And Download.



239Specifications

Printing Specifications

�  Graphic Image Printing

Data format Canon extended mode — Raster image format

Resolution Canon extended mode — 180, 360, 720 dpi

�  Compatible BJ Cartridges

BC-20 Black BJ Cartridge
Nozzles 128
Ink colors Black only
Capacity Approx. 900 text pages at 5% coverage

BC-21e Color BJ Cartridge
Nozzles 24 per color, 64 for black
Ink tanks BCI-21 Color (Cyan, Yellow, Magenta)

BCI-21 Black (Black)
Capacity Approx. 130 sheets per cartridge at 7.5% 

coverage

BC-22e Photo BJ Cartridge
Nozzles 24 per color, 64 for black
Ink colors Black, Cyan, Magenta, Yellow
Capacity Approx. 65 sheets per cartridge at 7.5% coverage
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Printing Specifications

�  Printer Driver Operating Environment

• IBM PC/AT-compatible computer running on Windows 2000, Windows 98, 
Windows 95, Windows NT 4.0, or Macintosh computers with USB 
interface running on Mac OS 8.1 or later

�  Hard Disk Space

• Approx. 38 MB to install on Windows 2000, Windows 98, or Windows 95
• Approx. 30 MB on Mac OS
• Approx. 29 MB on Windows NT 4.0 (including temporary files)

• BJ Status Monitor cannot be used when printer is used in network 
operating environment.

• When connecting printer and computer through USB interface, use the 
system under the following operating environment.

Computer with Microsoft Windows 2000 or Windows 98, which is 
preinstalled by a computer manufacturer on purchase. (USB port 
operation also needs to be assured by the manufacturer.)

Macintosh computers with USB and Mac OS 8.1 or later, which is 
preinstalled by a computer manufacturer on purchase. (When using an 
iMac running under Mac OS 8.1, the system must be upgraded using iMac 
Firmware 1.0, which can be downloaded from the home page of Apple 
Computer, Inc.)

Specifications subject to change without prior notice.

Note

Windows

Macintosh
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Printing Area

To ensure the best print quality, the printer allows a margin along each edge of  
media. 

Printing area (dark blue): Canon recommends that you print within this area. 
( )

Printable area (light blue): The area where it is possible to print. However, printing 
in this area can adversely affect the print quality or the 
paper feed precision. ( )

 Letter, Legal
 A5, B5, A4
 Glossy Photo Cards
 US Com. #10 Envelope
 European DL Envelope
 Banner Paper
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Printing Area

Letter, Legal

Media Type Printable Area (width x height)

Letter 8.0 × 10.61 in

Legal 8.0 × 13.61 in

1.0 in

0.93 in

0.25 in 0.25 in

0.28 in

0.12 in

Recommended printing area

Printable area
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Printing Area

A5, B5, A4

Media Type Printable Area (width x height)

A5 141.2 × 200.0 mm

B5 175.2 × 247.0 mm

A4 203.2 × 287.0 mm

25.4 mm

23.5 mm

3.4 mm 3.4 mm

7.0 mm

3.0 mm

Recommended printing area

Printable area
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Printing Area

Glossy Photo Cards

Media Type Printable Area (width x height)

Glossy Photo Card 4.31 × 6.30 in

0.20 in 0.16 in

1.02 in

1.10 in

Recommended printing area
(The printable area is identical 
to each other.)
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Printing Area

US Com. #10 Envelope

Media Type Printable Area (width x height)

 US Com. #10 9.0 × 3.81 in

1.0 in

0.93 in

0.25 in 1.25 in

0.28 in

0.12 in

Recommended printing area

Printable area
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Printing Area

European DL Envelope

Media Type Printable Area (width x height)

European DL 203.2 × 100.0 mm

25.4 mm

23.5 mm

6.4 mm 10.4 mm

7.0 mm

3.0 mm

Recommended printing area

Printable area
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Printing Area

Banner Paper

Media Type Printable Area (width x height)

Banner Paper 8.24 × 65.88 in. (Letter)

203.2 × 1779.0 mm (A4)

0.13 in (letter)
3.4 mm (A4)

0.13 in (letter)
3.4 mm (A4)

0.12 in (3.0 mm)
1.0 in (24.5 mm)

Max. 6 sheets
Min. 2 sheets

Recommended printing area

Printable area
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Using the Scanner

Scanner Driver Basics

Unpacking the Scanner Cartridge

Installing the IS Scan Software

Installing the Scanner Cartridge

Basic Scanning Procedure

Using the White Calibration Sheet

Scanning Area Guidelines

Loading an Image
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Scanner Driver Basics

Installing the optional IS-22 Color Image Scanner Cartridge in the printer makes it possible 
to scan and save images such as your favorite photographs and greeting cards.

Photograph

Wallpaper for your computer 

Home page 

Greeting card
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Scanner Driver Basics

To use the scanner cartridge, you must install the IS Scan software, which includes the 
IS Scan scanner driver and the IS Scan Plus utility program. These two programs provide 
many features that allow you to perform simple color adjustments to improve the quality of 
the original image or enhance the image for artistic effect.

You can run the IS Scan driver from within a TWAIN-compliant graphics application 
program, or you can run the IS Scan Plus utility program directly as a stand-alone 
application program. The IS Scan Plus utility program allows you to scan, edit, enhance, 
and save the image data.

To use the scanner cartridge, you must install the IS Scan software. You can run the 
IS Scan driver from within a TWAIN-compliant graphics application, or you can run it 
directly as a stand-alone program.

TWAIN is an industry interface standard that allows software applications 
to communicate with digital imaging devices such as scanners. 
Applications that support TWAIN provide a standardized method of 
acquiring images.

Windows

Macintosh

Note
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Unpacking the Scanner Cartridge

Make sure you have the following items.

�  IS-22 Color Image Scanner Cartridge

The scanner cartridge is composed of precision components. To avoid 
poor scanning results, do not touch the optical components or electrical 
contacts.

Optical components Electrical contacts

Do not touch these areas

Caution
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Unpacking the Scanner Cartridge

�  White Calibration Sheet
You use this sheet to maintain the correct color balance of scanned images. The first time 
you install the scanner cartridge, you need to run the white level calibration. You will also 
run calibration when the white level calibration data needs to be updated.

�  Scanning Holder
You can use this holder to hold a photo or other small image you wish to scan. The holder is 
two layers, one being a clear plastic cover to protect photographs.

�  Scanner Cartridge Container
Use this plastic container to store the IS-22 Color Image Scanner Cartridge.
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Installing the IS Scan Software

Before installing the IS Scan software, you must install the BJC-2100 Printer Driver.

1 Make sure the Install Me First CD-ROM is inserted in your CD-ROM drive.

2 Double-click the BJC-2100 icon on your desktop:   

You’ll see this screen:
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Installing the IS Scan Software

3 Click the Manuals, Supplies, and Help button. You’ll see this screen:
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Installing the IS Scan Software

4 Click Canon Accessories and Paper. You’ll see this screen:

5 Click the Install IS-22 Driver button.

6 Follow the instructions on the screen.
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Installing the Scanner Cartridge

• The scanner cartridge is composed of precision components. To avoid 
poor scanning results, do not touch the optical components or electrical 
contacts.

• To avoid damaging the scanning head of the scanner cartridge, do not 
store the scanner cartridge in an SB-21 Ink Cartridge Storage Box. The 
pad for the BJ cartridge print head inside the container is covered with 
ink that could damage the scanning head of the scanner cartridge. 
Always store the scanner cartridge in its plastic container.

Optical components Electrical contacts

Do not touch these areas

Caution
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Installing the Scanner Cartridge

�  Replacing a BJ Cartridge With the Scanner Cartridge

1 Make sure that the printer is plugged in and open the front cover. The 
cartridge holder moves to the center automatically.

2 Raise the cartridge lock lever to unlock the BJ cartridge.

3 Remove the BJ cartridge.

To avoid staining your hands, clothing, or work area, handle the 
BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge. 
Store the BJ cartridge in the Ink Cartridge Storage Box.

Caution
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Installing the Scanner Cartridge

4 Insert the scanner cartridge into the cartridge holder, then lower the 
cartridge lock lever until it locks in place.
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Basic Scanning Procedure

After installing the IS Scan scanner driver, you can use the BJC-2100 printer as a scanner.

1 Install the IS-22 Color Image Scanner Cartridge.

Remove the BJ cartridge installed in the cartridge holder and then install 
the IS-22 Color Image Scanner Cartridge.

2 Start a graphics application program.

For Windows Users

• If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program. IS Scan launches from within the application 
program.

• If you use IS Scan Plus, select Programs from the Start menu first. Point to 
IS Scan Plus and then select IS Scan Plus.

For Macintosh Users

• If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program first. IS Scan launches from within the application 
program.

• If you use IS Scan as a stand-alone application program, double-click IS Scan 
BJC-2100 in the folder you specified during the installation procedure.

Windows

Macintosh
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Basic Scanning Procedure

3 The first time you use the scanner, you need to perform the White Level 
Calibration.

 Using the White Calibration Sheet

4 Insert the image you wish to scan into the scanning holder, then load the 
scanning holder into the auto sheet feeder.

 Loading an Image

5 Scan the image.

 Scanning an Image

 Scanning an Image

6 Save the scanned image.

7 Now you can install the BJ cartridge and print the scanned image.

Windows

Macintosh
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Using the White Calibration Sheet

The white calibration sheet provided with the scanner cartridge is used for maintaining the 
correct color balance of scanned images. White level calibration is required when the 
scanner cartridge is used for the first time and when the white level calibration data needs 
to be updated.

When white level calibration is needed, you will see this screen when you click the Prescan 
or Scan buttons.

  

Windows

Macintosh

Download from Www.Somanuals.com. All Manuals Search And Download.



263Using the Scanner

Using the White Calibration Sheet

1 Load the white calibration sheet with the cropped corner at the upper left.

2 Follow any instructions on your screen.

3 When the white calibration sheet is ejected from the paper output tray, 
white level calibration processing is complete. 
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Using the White Calibration Sheet

• Do not leave the white calibration sheet in locations that are exposed to 
direct sunlight or that are subject to high temperatures or humidity.

• Do not bend or wrinkle the white calibration sheet.

• When cleaning the white calibration sheet, use a soft cloth that is dipped 
in a weak, neutral detergent solution, and then wipe its wet surface off 
with a dry, soft cloth.

• The white level calibration data is stored into memory and used for 
maintaining the correct color balance of scanned images. When a 
message appears and prompts you to load the white calibration sheet, 
click the OK button and perform white level calibration.

You can also initiate White Level Calibration from the IS Scan driver.

 Other IS Scan Features

 Other IS Scan Functions

Note

Windows

Macintosh
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Scanning Area Guidelines 

• The scanning area varies according to conditions such as the scanning 
resolution and display resolution.

• If you wish to scan images larger than the size of the scanning holder 
provided with the IS-22 Color Image Scanner Cartridge, the SH-101 
A4/LTR scanning holder is available for purchase. Visit the Canon Web 
site to find out about accessories and supplies (www.ccsi.canon.com).

• The maximum thickness of the image must be within 0.45 mm, including 
the scanning holder. The scanning holder is 0.2 mm thick so the image 
you wish to scan must be less than 0.25 mm thick.

• To prevent possible damage to the printer or scanner cartridge, do not 
scan an image with paper clips or staples.

Paper size Scanning area

A6 (105.0 × 148.0 mm) 3.86 × 5.43 Inches

A5 (148 × 210 mm) 5.55 × 7.87 Inches

A4 (210 × 297 mm) 8.50 × 11.29 Inches

B5 (182 × 257 mm) 6.89 × 9.72 Inches

Letter (8.5 × 11 in) 8.19 × 10.60 Inches

Legal (8.5 × 14.0 in) 8.19 × 13.09 Inches

Note
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Loading an Image

1 Slide the paper guide to the left edge of the auto sheet feeder.

2 Place the image in the scanning holder.

• To prevent paper jams, always insert the image you wish to scan into 
the scanning holder.

• Do not leave the scanning holder in locations that are exposed to direct 
sunlight or that are subject to high temperatures or humidity.

• When you load the scanning holder on the printer, be sure to set the 
paper thickness lever to the right (envelope position). Scanning with the 
lever set incorrectly will adversely affect the print quality.

3 Load the scanning holder in the auto sheet feeder of the printer.
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Loading an Image

4 Adjust the paper guide to the left edge of the scanning holder.

To prevent possible damage to the scanning holder, always insert the 
seamed side into the auto sheet feeder first.

A

A

Caution
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Using the Scanner With Windows

Using IS Scan

Changing the Scanning Mode

Using the Customized Scanning Mode

Saving the Settings

Using the Saved Settings

Other IS Scan Features

Using IS Scan Plus

Using Copy

Using Capture Image

Using Capture Photo

Editing a Scanned Image

Printing a Scanned Image

Saving a Scanned Image
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Using IS Scan

 

This section describes how to scan an image when you start IS Scan from within a 
TWAIN-compatible application program.

 

�  

 

Scanning an Image

 

These basic procedures may vary according to the application program 
you are using.

 

1

 

Install the IS-22 Color Image Scanner Cartridge in the printer.

 

 

Installing the Scanner Cartridge

 

2

 

Make sure Canon IS Scan 2 is set as the Acquire Source and then select 
the command used for scanning (such as Acquire or TWAIN) from the 
menu of the application program. The main IS Scan dialog box displays:

Note
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Using IS Scan

3 Specify the basic settings.

• Click the down-arrow on the right of the Paper Size box and select the 
most appropriate paper size for the image you wish to scan.

• Select the most appropriate scanning mode for the image you wish to 
scan in the Scanning Mode box.

 Changing the Scanning Mode

4 Load the image you wish to scan in the auto sheet feeder of the printer 
and click the Prescan button.

It’s a good idea to use prescanning to determine whether or not an image 
can be scanned properly or to test the effects of image adjustments. If the 
image is slanted or a portion of the image is cut off in the preview area, 
click the Clear button. Load the image correctly and click the Prescan 
button again.

5 To scan only a portion of the image, you can drag the mouse to specify the 
portion. The specified portion is called a Selection Box and only the area in 
the Selection Box will be scanned. To specify the Selection Box:

• Point to a corner of the rectangular area of the image that you want to 
select.

• Drag the mouse to the opposite corner of the rectangle.

Note
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Using IS Scan

• Release the mouse button. The Selection Box appears on the image. 

• To move the Selection Box, place the mouse pointer within the Selection 
Box and drag the mouse to the desired position.

• To resize the Selection Box, point to a corner of the Selection Box and 
then drag the mouse.

• You can confirm the dimensions of the Selection Box in the Image Size 
box.

• The minimum size of the Selection Box is 1" × 1" (25.4 mm × 25.4 mm).

Note
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Using IS Scan

6 Load the image you wish to scan in the auto sheet feeder again.

7 Click the Scan button. Remember, if you specified a Selection Box in 
step 5, only that portion of the image is scanned.

8 After scanning is complete, click the Transfer button to transfer the image 
data to the TWAIN-compatible graphics application program. Adjust, edit, 
or enhance the image in the application program as needed.
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Using IS Scan

• Some TWAIN-compliant graphics application programs do not display 
the main IS Scan dialog box but instead display a different screen 
characteristic of the application program. If you are using this type of 
application program, read the documentation of the application program 
carefully and perform prescanning or normal scanning.

• After launching IS Scan from within a TWAIN-compatible application 
program, do not close the application program. If you do, the system may 
not be able to respond.

• To quit IS Scan, select Exit Driver from the Settings menu.

Note
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select the most appropriate icon in the Scanning Mode box of the main IS Scan dialog box 
according to your scanning purpose.

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Standard setting for scanning a 
color image

Color
180 dpi

Off
Off
On

Grayscale

Standard setting for scanning a 
monochrome image

Grayscale
180 dpi

Off
Off
Off

Grayscale

Suitable for scanning a 
photographic print such as a 
snapshot

Color
360 dpi

Off
Off
On

Grayscale
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Changing the Scanning Mode

When you select FAX or OCR, the document is scanned and processed as 
a grayscale image and converted to monochrome binary image data. This 
process eliminates unnecessary image background and increases the 
quality of the scanned text and line art. When you select Text, the 
document is scanned and processed as a monochrome image.

Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Monochrome
200 dpi

Off
On
Off

Monochrome

Scans by converting a 
monochrome image into the 
data suitable for OCR input

Monochrome
360 dpi

Off
On
Off

Monochrome

Suitable for scanning an image 
that consists mostly of text

Monochrome
180 dpi

On
Off
Off

Monochrome

Used for customizing the 
settings for special scanning 
jobs

Using the Customized 
Scanning Mode

— — —

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Note
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Using the Customized Scanning Mode

When you select Custom in the Scanning Mode box of the main dialog box, the Custom 
dialog box opens and allows you to adjust the scanning settings for special scanning 
jobs. 

1 Open the main IS Scan dialog box.

2 Click the Custom button in the Scanning Mode box. This displays the 
Custom dialog box:
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Using the Customized Scanning Mode

3 Specify these settings in the Custom dialog box:

Standard Value
You change the standard value for the default settings here. Select from: 
DTP(Color), DTP(B&W), Photo, FAX, OCR, Text, Previous Setting.

Image Type
Select a type of image: Color (the default), Grayscale, or Monochrome.

Resolution
Determines the precision of the scanned image. The higher the resolution 
setting, the higher the precision and quality of the scanned image. 
(However, the higher the resolution setting, the larger the file size.) Possible 
settings: 90, 180, 200, 300, 360.

• The 90 dpi setting is sufficient for viewing images on a screen.
• The 180 dpi setting is sufficient for printing images.

Threshold
Determines the intensity of halftones for monochrome images. Drag the 
slide bar to the left for a lighter image or drag it to the right for a darker 
image. The Threshold option is available only when the Image Type is set 
for Monochrome and Character Emphasis is off.

Edge Emphasis
Sharpens the edges of a soft image to create a clearer, more accented 
appearance in the entire image. This option is available only when the 
Image Type is set for Monochrome. Edge Emphasis is not used with 
prescanning.
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Using the Customized Scanning Mode

Character Emphasis
Determines whether or not Image Trust processing is used for scanning 
grayscale images. Image Trust processing sharpens the appearance of 
characters in monochrome documents. This is especially helpful if you 
intend to use the scanned original with an OCR software application. This  
option is available only when the Image Type is set for Monochrome.

Color Matching
In some cases, the colors displayed on your monitor may not match the 
colors you see in your printout. Color Matching attempts to match the 
colors of the scanned image with the selection in the Monitor Type box in 
order to attain a better match between the colors you see on the monitor 
and the colors you see in your printout. This option is available only when 
the Image Type is set for Color.

Monitor Type
Displays the name of the monitor profile currently in use. To select another 
monitor type setting, click the down-arrow and select a name from the drop-
down list. This list includes the names of ICC profile formats, standard 
profiles for monitors, installed in the system. A monitor profile can be 
selected only when Color Matching is selected.

Prescan
Selects the type of image for prescanning. Select Monochrome, Grayscale 
(the default) or Color.
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Using the Customized Scanning Mode

4 Click the OK button to return to the main dialog box.

5 Make sure that the image you wish to scan is inserted into the scanning 
holder properly and is loaded in the auto sheet feeder of the printer, then 
click the Scan or Prescan button.
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Saving the Settings

You can save the settings in the main IS Scan dialog box to a file. The next time you scan, 
you only need to open the file in which the desired settings are stored and start scanning.

�  Saving the Settings to a File
Save the Page Size, Scanning Mode, and Image Size settings in the main IS Scan dialog 
box as a file.

1 Specify the desired settings in the Page Size, Scanning Mode, and Image 
Size boxes.

2 Select Save Settings File from the Settings menu.

3 Select the folder in which the file is to be saved.

4 Enter a File name.

5 Click the Save button.
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Using the Saved Settings

Open the file in which the desired settings were saved and use those settings for scanning.

1 Select Open Settings File from the Settings menu.

2 Select the file you wish to use, then click the Open button. The file name 
is displayed in the Settings File box, and the settings change in the main 
IS Scan dialog box.

• When you open the file while an image is displayed in the preview area, 
the prescanned or scanned image is discarded. Prescan or scan the 
image again.

• Select Save Settings File from the Settings menu when you have 
changed the settings and you wish to overwrite the current file and save 
all the current settings to it.

• Select Save Settings File As from the Settings menu when you have 
changed the settings and you wish to save all the current settings under 
a new file name.

Note
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Other IS Scan Features

�  White Level Calibration
Use this feature to maintain the correct color balance of scanned images. You need to 
perform white level calibration when you use the scanner cartridge for the first time and 
when the white level calibration data needs to be updated.

1 Select White Level from the Option menu of the main IS Scan dialog box.

2 When a message appears, insert the white calibration sheet into the auto 
sheet feeder of the printer.

 Using the White Calibration Sheet

3 Click the OK button.

4 When the white calibration sheet is ejected from the paper output tray, the 
White Level Calibration process is complete.

�  Device Information
When you select Device Information from the Option menu of the main IS Scan dialog box, 
you can verify the name of the printer that is currently connected to your system and 
information on the communication mode.

• If the printer is connected using the parallel interface, Device Information displays a 
communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays USB as 
the communication mode.
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Other IS Scan Features

�  Enlarging the Scanned Image in the Preview Area

To enlarge the scanned image in the preview area, click the Enlarge icon (  key) or 

select Large from the View menu.

To return to the original size, click the Standard icon (  key) or select Normal from the 

View menu.

�  Using Online Help

When you click the  symbol in the main IS Scan dialog box, the online Help for IS Scan 

opens so you can learn more about IS Scan.
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Using IS Scan Plus

IS Scan Plus is a utility program that allows you to edit, enhance, print, and save an image 
acquired by the IS Scan scanner driver. You can use IS Scan Plus if you do not have a 
graphics application program.

�  Launching IS Scan Plus

1 Select Programs from the Start menu, then click IS Scan Plus.

2 Select IS Scan Plus. The main IS Scan Plus screen appears:
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Using IS Scan Plus

3 Select an option:

Copy
Scan and immediately print an image without editing.

 Using Copy

Capture Image
Scan and edit an image other than a photographic print.

 Using Capture Image

Capture Photo
Scan and edit a photographic print such as a snapshot.

 Using Capture Photo

Device Information
Verify the name of the printer that is currently connected to your system 
and information on the communication mode.
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Using IS Scan Plus

�  Using Online Help
When you need detailed instructions, click the Help button in the upper right of the main 
screen. You can access the online Help from all the screens that IS Scan Plus displays.

�  Verifying the Device Information
Make sure that the printer is connected properly and is turned on, and click the Device 
Information button.

• If the printer is connected using the parallel interface, Device Information displays a 
communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays USB as 
the communication mode.

�  Closing IS Scan Plus
When you wish to close IS Scan Plus, click the Exit button in the upper right of the main 
screen. You can access the Exit button from all the screens that IS Scan Plus displays.
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Using IS Scan Plus

�  IS Scan Buttons

Returns to the main IS Scan Plus screen.

Moves back to the previous screen.

Displays the Edit screen.

 Editing a Scanned Image

Prints a scanned image.

 Printing a Scanned Image

Saves a scanned image.

 Saving a Scanned Image
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Using Copy

Use the Copy feature when you wish to print an image immediately after scanning. You 
cannot edit or enhance the scanned image before printing.

1 Click the Copy button in the main IS Scan Plus screen. The Copy screen 
displays:
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Using Copy

2 Specify any required settings:

• Select Color or Monochrome in the Document Type box.

• Select Fine or Fast in the Copy Mode box.

• Select the paper size in the Paper Size box.

• The Copies option is disabled.

3 Click the Print Setting button. This displays the Print Setup dialog box. 
Make sure Canon BJC-2100 is displayed as the default printer. Click the 
Properties button, if necessary, to display the Printer Properties dialog box 
and specify any printer settings. 

 Opening the Printer Properties Dialog Box

Download from Www.Somanuals.com. All Manuals Search And Download.



290Using the Scanner With Windows

Using Copy

4 When you click the Copy button, a message box appears. Click the OK 
button in the message box to confirm that the scanner cartridge is 
installed. Copying begins.

5 Another dialog box appears to remind you to remove the scanner 
cartridge, and install the BJ cartridge according to your print job. Also, 
make sure paper is loaded in the auto sheet feeder of the printer.

6 Click the OK button in the dialog box. Printing begins.

• To print the image displayed in the Preview Area again, click the Reprint
button.

• To make a copy of another image using the same settings, click the Copy 
button. When a confirmation message appears, click the Yes button and 
repeat the procedure described above.

• To make a copy using different settings, click the Clear button to clear 
the copied image from the preview area. Repeat the procedure 
described above.

Note
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Using Capture Image

Use the Capture Image feature to scan an image other than a photographic print. You can 
also edit, enhance, save, and print the scanned image.

1 Click the Capture Image button in the main IS Scan Plus screen. This 
displays the Capture Image screen.

2 Select the most appropriate icon in the Scanning Mode box of the Capture 
Image screen according to your scanning purpose.

Standard setting for scanning a color image.

Standard setting for scanning a monochrome image.

Suitable for scanning a photographic print such as a 
snapshot.

Suitable for scanning an image that consists mostly of text.

Used for customizing the settings for special scanning jobs.

 Using the Customized Scanning Mode
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Using Capture Image

3 Select the paper size in the Paper Size box.

4 Insert the image you wish to scan in the scanning holder, and then load it 
in the auto sheet feeder of the printer.

5 Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image 
Using IS Scan.

 Scanning an Image
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Using Capture Photo

Use the Capture Photo feature to scan a photographic print such as a snapshot. You can 
also edit, enhance, save, and print the scanned image.

1 Click the Capture Photo button in the main IS Scan Plus screen. The 
Capture Photo screen displays:

By default, a Selection Box appears in the Preview Area. To delete the 
Selection Box, point to any location in the Preview Area and right-click 
your mouse.
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Using Capture Photo

2 Specify these settings:

• Select Color or Black & White in the Photo Type box.

• Select Regular or Panorama in the Photo Size box.

3 Insert the image you wish to scan into the scanning holder, and then load it 
in the auto sheet feeder of the printer.

4 Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image.

 Scanning an Image
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Editing a Scanned Image

You can edit or enhance a scanned image acquired using the Capture Image or Capture 
Photo feature. The editing features you can use vary according to the settings you used for 
scanning and whether you used the Capture Image or Capture Photo feature for scanning.

You can edit or enhance the image displayed in the Preview Area.

1 Click the Edit button in the main IS Scan Plus screen. The Edit screen 
displays:
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Editing a Scanned Image

2 You can select these editing options. For details on each feature, use the 
online Help for IS Scan Plus.

Contrast / Brightness
Adjusts the brightness and contrast of an image.

Image Compensation
Softens edges in the image by reducing the contrast between pixels, or 
sharpens hazy or blurred images. You can also smooth the appearance of 
the image and/or invert the image.

Edges
Enhances the edges in an image by increasing the contrast of the pixels 
between areas of different colors. 

Lines
Emphasizes selected edges and de-emphasizes all other edges of an 
image.

Pixelize
Squares off all the pixels in an image to lower resolution and makes the 
pixels appear larger to create a mosaic tile effect.

Posterize
Reduces the number of colors in an image.

Low Relief
Applies special options to create a three-dimensional effect in the image.
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Editing a Scanned Image

Background
Allows you to add a background to a monochrome image.

Crop Photo
Crops a scanned photograph in the Preview Area.

Frame
Allows you to add a frame border around the image.

• Depending on the settings you use for scanning, some editing features 
are not available. For details, see the online Help for IS Scan Plus.

• You cannot use Crop Photo and Frame in the Capture Image screen. 
You can select Background when a monochrome image is captured.

3 Edit or enhance the image as required.

4 Click the Apply button to apply the effect to the image in the Preview Area.

To undo the settings, click one of the undo buttons:

Undo All
Click once to undo all editing effects and restore the original in the 
Preview Area.

Undo Previous
Click once to undo the previous editing effect; click repeatedly to undo 
each previous editing effect one by one.

Note
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Printing a Scanned Image

You can print a scanned image acquired using the Capture Image or Capture Photo feature. 
Remove the scanner cartridge, and install the BJ cartridge according to your print job.

Click the Print button on the IS Scan Plus screen. If you are using Capture Image, the Print 
dialog box appears: 
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Printing a Scanned Image

If you are using Capture Photo, the Photo Print Options dialog box appears:

Click Print Setting to change the printer settings or click Print to print the image.

 Opening the Printer Properties Dialog Box
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Saving a Scanned Image

IS Scan Plus allows you to save a scanned image to a file under a new name. You can use 
the saved image for pasting into another document or for attaching to your e-mail or a home 
page on the Internet.

You can save the image displayed in the Preview Area.

1 Click the Save button. This displays the Save As dialog box.

2 Select the folder in which you wish to save the image.

3 Enter a File name.
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Saving a Scanned Image

4 Click the down-arrow for “Save as type” and select a format for the file.

You can select one of the following file formats.

• Bitmap .BMP

• JPEG .JPG

• TIFF .TIF

5 Click the Save button.
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Using the Scanner With Macintosh

Scanning Images With Application Software

Using the Main IS Scan Dialog Box

Scanning an Image

Scanning Images With IS Scan

Changing the Scanning Mode

Customizing the Scanning Settings

Copying a Scanned Image to the Clipboard

Adjusting an Image

Modifying An Image

Applying Special Effects to an Image

Other IS Scan Functions

Using the Copy Utility
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Scanning Images With Application Software

This section explains how to start IS Scan from a TWAIN image editing application software 
so that you can scan images. 

�  Selecting a TWAIN-compatible Device
Before you scan images with application software, you must first select a TWAIN-
compatible device using the BJC-2100 driver. The basic procedure is described below 
(steps may vary based on your application software).

1 Start the application software and then select New... from the File menu. 
Then, open the menu you use to scan images. Install the scanner 
cartridge in the printer.

2 To open the dialog box for selecting a TWAIN-compatible input device, you 
normally select Import and then select TWAIN Select... from the File 
menu. The “Select a source” dialog box is displayed.
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Scanning Images With Application Software

3 Click the IS Scan BJC-2100 DS icon and then click the OK button.

BJC-2100 is now selected as the input device. Once you have performed 
these steps, the setting remains in effect until you change to another input 
device.
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Using the Main IS Scan Dialog Box

Menu button
Selects the IS Scan functions. Click this button to change the settings for a scanned 
image or to edit a scanned image.

Menu Button

Scan Button

Save Button

Halt Button

Help Button

Information Box

Image Control 
Panel

Brightness and 
Contrast

Preview Area
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Using the Main IS Scan Dialog Box

Scan, Prescan, or Clear button
Click this button to start scanning. This button switches to Prescan or Clear, 
depending on the setting or situation.

Transfer or Save button
Click this button to transfer a scanned image to an application. When using IS Scan 
only without an application software, this button says Save.

Halt button
Click this button to cancel scanning.

Information box
Displays the settings related to image scanning. To perform scanning using other 
settings, click the Menu button and then select Settings.

Help button
Click this button to display helpful explanations about the IS Scan functions.

Brightness and Contrast 
Click this button to adjust the degree of brightness of an image.

Image Control Panel
Displays the size of the image to be scanned. For units, you can select inches, mm, 
or pixels. 

Preview area
Displays a scanned image.
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Scanning an Image

1 Click the Menu button and then select Settings. The Settings dialog box 
displays:

2 Make the necessary settings for the image to be scanned.

• Click on Paper Size to select a size that approximates the image to be 
scanned.

• Click on Scanning Mode to select the item that best approximates the 
image to be scanned.

 Changing the Scanning Mode
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Scanning an Image

• Place a check mark in the Prescan check box. 
Prescan performs a quick scan so you can check the image. You can 
disable this function.

3 Click the OK button and then close the Settings dialog box.

4 Place the object to be scanned in the printer and then click the Prescan 
button. You see the image displayed in the Preview Area.

5 If you only want to scan part of the object, drag the mouse within the 
Preview Area to select the part to be scanned. The Selection Box indicates 
the area that will be scanned.
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Scanning an Image

• To create a Selection Box, position the cursor over one corner of the 
area to be selected, press and hold down the mouse button, and then 
drag the mouse diagonally to the opposite corner of the area you want to 
select. Release the mouse button.

• If you position the cursor over a point within the selected area, you can
move the area by dragging. If you position the cursor over one of the 
lines indicating the selected area, you can change the size of the 
selected area by dragging that line in or out.

• The minimum size of the selected area is 1" × 1" (25.4 mm by 25.4 mm).

• The size of the selected range is displayed in the Image Control Panel. 

6 Place the image to be scanned in the printer and click the Scan button. 
Remember, only the range indicated by the Selection Box is scanned.

Note
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Scanning an Image

7 If the image displayed in the Preview Area is not what you expect, click the 
Clear button and start over.

If you like the image, click the Transfer button. The scanned image is 
transferred to the application software. Edit the image data as required 
prior to printing or saving it.

• Some application programs do not display the main IS Scan dialog  
box, but display their own scanning screen. In this case, refer to the 
documentation supplied with the scanning software.

• Do not close an application program that started IS Scan while 
IS Scan is still running. This may cause the system to lock up.

Note
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Scanning Images With IS Scan

You can use IS Scan as a stand-alone program to scan and edit images.

�  Starting IS Scan

1 Turn on the printer and install the scanner cartridge.

2 Double-click the IS Scan BJC-2100 folder.

3 Double-click the IS Scan BJC-2100 icon.
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Scanning Images With IS Scan

IS Scan starts and the main dialog box displays.

The contents of the main dialog box and the method you use to scan 
images are basically the same as when using TWAIN application software.
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Scanning Images With IS Scan

�  Saving Scanned Images

1 Click the Save button.
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Scanning Images With IS Scan

2 Make the necessary settings.

• Select the location to which you want to save your image.

• Enter a name for the image data in Name.

• Click the up- or down-arrow in Format to select PICT or TIFF.

3 Click the Save button. The image data is saved into a file.
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select a setting that best approximates the image to be scanned. 

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*

DTP 
(Color)

Standard setting used when a 
color draft is to be scanned

Color
180 dpi

Off
On (Execute)

Grayscale

Photo Recommended when scanning 
a photograph

Color
360 dpi

Off
On (Execute)

Grayscale

DTP 
(B&W)

Standard setting used when a 
black & white draft is to be 
scanned

Grayscale
180 dpi

Off
Off

Grayscale

*By default, Prescan is not enabled. When enabled, B&W is the default Prescan Mode. 
You can choose Color, Grayscale, or Black & White.
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Changing the Scanning Mode

Text Recommended when scanning 
a document consisting entirely 
of text, such as a document 
created with a typewriter or 
word processor

Black & 
White
180 dpi

On (Execute)
Off

Black & 
White

FAX Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Black & 
White 
(Text 
Enhanced)
200 dpi

Off
Off

Black & 
White

OCR Scans by converting a 
monochrome image into the 
data suitable for OCR input

Black & 
White 
(Text 
Enhanced)
360 dpi

Off
Off

Black & 
White

Custom Selected when a specific range 
of settings are to be made

Customizing the 
Scanning Settings

––––– ––––– –––––

*By default, Prescan is not enabled. When enabled, B&W is the default Prescan Mode. 
You can choose Color, Grayscale, or Black & White.

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*
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Changing the Scanning Mode

• The Settings dialog box displays when you select Settings after you click 
the Menu button in the main dialog box.

• When you select FAX or OCR, the document is scanned and processed 
as a grayscale image and converted to monochrome binary image data. 
This process eliminates unnecessary image background and increases 
the quality of the scanned text and line art. When you select Text, the 
document is scanned and processed as a monochrome image.

Note
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Customizing the Scanning Settings

When you select Custom for Scanning Mode in the Settings dialog box, you can specify the 
scanning settings.

1 Click the Menu button in the main dialog box and then select Settings.

2 Click the up- or down-arrow in Scanning Mode and then select Custom.
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Customizing the Scanning Settings

3 Make the appropriate settings for the image to be scanned.

Image Type
Select a mode according to the image to be scanned. You can select 
Color, Grayscale, Black & White, or Black & White (Text Enhanced).

Resolution
Select a resolution according to the image to be scanned. The higher the 
resolution, the finer the image you can get, although the amount of data 
will be large. In general, 90 dpi is sufficient for home pages, while 180 dpi 
is good for output to a printer. Available settings: 90, 180, 200, 300, 360.

Threshold
This function is valid only when Image Type is set to Black & White. The 
lightness/darkness of monochrome images can be adjusted by moving the 
slide bar. If the slide bar is moved to the left, the scanned image will be 
lighter, while if the slide bar is moved to the right, the image will be darker.

Prescan
Place a check mark in the Prescan check box to perform the prescan. The 
scanning mode can be set to Black & White, Grayscale, or Color.

Color Matching
This function is effective only when Image Type is set to Color. When this 
function is enabled, the colors are adjusted according to the monitor when 
the image is scanned. The monitor itself is set with the system feature of 
ColorSync® in the Apple menu control panel.
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Customizing the Scanning Settings

Edge Emphasis
This function is valid only when Image Type is set to Black & White. If this 
function is selected, only the edge of the image is emphasized when the 
image is scanned. This is disabled for prescan.

4 Click the OK button. The main IS Scan dialog box displays.

5 Place the image to be scanned in the printer, then click the Prescan button 
or Scan button to start scanning.
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Copying a Scanned Image to the Clipboard

If you copy a scanned image to the clipboard, you can use the image easily with other 
application software. This is particularly useful when you want to paste an image into 
documents created with application software that is not TWAIN-compatible.

�  Copying an Image

1 Click the Menu button in the main dialog box. Select Edit and then select 
Copy.

The image data is copied to the clipboard.

To use an image copied to the clipboard, start your application software 
and then select Paste from the Edit menu.

Note
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Adjusting an Image

If you are not satisfied with a scanned image, you can perform fine adjustment using a 
range of functions. Image data can be processed so that the brightness of the image 
changes or so that the image appears sharper or softer.

�  Adjusting the Brightness and Contrast

1 Click the Brightness and Contrast button in the main dialog box. The 
Brightness and Contrast dialog box displays.
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Adjusting an Image

2 Move each slide bar to the right or left to adjust the image.

Brightness
Moving the Brightness slide bar to the left makes the entire image darker, 
while moving it to the right makes the image brighter.

Contrast
Moving the slide bar to the left reduces the contrast of the entire image, 
while moving it to the right increases the contrast.

3 After making the adjustment, click the Apply button to change brightness 
and contrast of the image displayed within the preview area.

4 Once you are satisfied with the adjustment, click the OK button.
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Modifying An Image

You can modify a scanned image so that it looks sharper or softer. Also, a Despeckle 
function allows you to remove speckling and make a scanned image appear cleaner. A 
function for inverting colors to produce a negative film is also available.

1 Click the Menu button in the main dialog box, select Image, and then 
select the desired function from the submenu.

Sharpen Sharpens an image to make it clearer.

Soften Softens the edges of an image.

Despeckle Removes speckling from an image, making any such areas 
less noticeable.

Invert Inverts the colors of an image to produce a negative of the 
original.

You can check the effect of the adjustment in the Preview Area.
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Applying Special Effects to an Image

Special effects such as edge emphasis, line emphasis, pixelization, posterization, and low 
relief can be applied to a scanned image, creating an image with a feeling different from that 
of the original.

1 Click the Menu button in the main dialog box, select Enhance, and then 
select the desired function from the submenu.

Edges... Emphasizes the edges of a photograph or line drawing.

Lines... Emphasizes only lines in a specific direction.

Pixelize... Applies a mosaic effect to an image.

Posterize... Reduces the number of colors and simplifies the image.

Low Relief... Creates a low relief version of the image.

When you select one of these functions, the corresponding dialog box 
displays.
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Applying Special Effects to an Image

2 Select a desired function from the list.

The following is an example of the screen displayed when you select 
Edges. The operation is the same when any other function is selected. You 
can check the approximate result of the selection in the Preview Area.

For details of each function, refer to the explanation displayed when you 
click the Help button.
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Applying Special Effects to an Image

3 Once you are satisfied with the adjustment, click the OK button.

To cancel an adjustment you have made, click the Menu button and then 
select Undo. Then, select either of the following:

Last Only the function applied immediately before is cancelled. If you 
perform editing two or more times, only the function that you 
selected most recently is cancelled.

All All the applied functions are cleared and the original image is 
restored.

Note
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Other IS Scan Functions

�  White Level Calibration
To achieve the correct color balance for an object to be scanned, an operation called White 
Level Calibration is required. When an image is scanned for the first time, or when the 
temperature of the scanner cartridge rises to a certain level, a message displays prompting 
you to place the white calibration sheet in the printer.

Place the white calibration sheet in the printer and then click the OK button. The calibration 
sheet is scanned and the calibration is performed.

You can also initiate this operation whenever necessary. 

1 Click the Menu button in the main dialog box and then select Settings.

2 Click the White Level button.

3 When the message appears, place the white calibration sheet in the 
printer.

 Using the White Calibration Sheet

4 Click the OK button.

When the white calibration sheet is ejected, white leveling is complete.
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Other IS Scan Functions

�  Using the Online Help
Clicking the Help button on the main IS Scan dialog box displays helpful explanations of the 
functions of IS Scan. You can also display the Help by clicking the Menu button, Help, and 
then Help again.
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Using the Copy Utility

Use this utility to scan an object and then print the result immediately. Although the scanned 
image cannot be edited or saved, the process from scanning to printing is completed 
quickly and easily.

�  Installing the Copy Utility
To use the Copy Utility, you must first copy the folder including the necessary files to any 
location.

1 Load the Install Me First CD-ROM into the CD-ROM driver on your 
Macintosh.

2 Double-click on the Copy Utility folder.
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Using the Copy Utility

3 Drag the Copy Utility for BJC-2100 folder and copy it to any location.

Now you can start the Copy Utility at any time.

To use the Copy Utility, the printer driver and IS Scan scanner driver must 
also be installed.

�  Starting the Copy Utility

1 Plug in the printer and install the scanner cartridge.

2 Click the Copy Utility for BJC-2100 folder.

Note
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Using the Copy Utility

3 Click the Copy Utility icon.

The Copy Utility starts and the main dialog box displays:
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Using the Copy Utility

�  Copying the Image

1 Click the Color or Black & White button according to the image to be 
scanned.

2 Select the paper size you are using in Paper Size.

3 Select the number of copies to be output in Copies.

4 Select the type of paper you are using: Plain Paper, High Resolution 
Paper, or Transparency.

5 Set Brightness, as necessary. Move the slide bar to the right and left to set 
the brightness.

6 Place the image to be copied in the printer, then click the Copy button.

Scanning starts.

7 When the message appears, remove the scanner cartridge and replace it 
with a BJ cartridge according to the printing settings.

8 Place a blank sheet of paper in the printer and click the OK button.

Printing starts.
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Using the Copy Utility

• To print the same image again, click the Reprint button.

• To copy another document with the same settings, click the Copy button 
and follow the instructions on the screen.

• To perform copying with different settings, click the Reset button and 
follow the instructions on the screen.

�  Ending the Copy Utility
To close the Copy utility, click the close box or the Quit button.

Note

Close box
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Scanner Problems

Scanning Result Is Unsatisfactory

Scanner Cannot Be Used With a TWAIN-compatible Application Program

Other Scanner Problems
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Scanning Result Is Unsatisfactory

Scanned Image Blurred or Distorted

Quality of Scanned Image Is Uneven

White Portion Becomes Grayish

Parts of an Image Missing or Not Aligned Properly

Image Contains Unexpected Colors, or Is Too Light or Too Dark
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Scanning Result Is Unsatisfactory

�  Scanned Image Blurred or Distorted

CHECK 1 ARE YOU USING A CLEAR IMAGE FOR SCANNING?

Blurry images are not suited for scanning. For best scanning results, 
always use a clear, sharp image. (The scanned image cannot be better 
than the original image.)

CHECK 2 IS THE SCANNING HOLDER UNSTAINED AND UNDAMAGED?

The scanning holder is bound to get dirty. Clean the scanning holder using 
a soft cloth that is dipped in a weak, neutral detergent solution, and then 
wipe its wet surface off with a dry, soft cloth.

If the scanning holder is scratched or damaged, replace it.

You can purchase a scanning holder for A4/LTR-size images. Visit the 
Canon Web site to find out about accessories and supplies 
(www.ccsi.canon.com). 

CHECK 3 ARE YOU SCANNING THICK PAPER?

The image being scanned must be thinner than 0.25 mm. The thickness 
including the scanning holder must be thinner than 0.45 mm.

Note
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Scanning Result Is Unsatisfactory

�  Quality of Scanned Image Is Uneven
The scanned image is coarse and/or blurry.

CHECK IS THE RESOLUTION SETTING HIGH ENOUGH?

Resolution determines the precision of the scanned image.

The greater the number of dots used to draw an image, the higher the 
precision and the quality of the scanned image becomes. For a better 
quality image, select a greater number.

The scanning speed becomes slower and the file size of the scanned 
image becomes larger when you use a higher resolution.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh
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Scanning Result Is Unsatisfactory

�  White Portion Becomes Grayish
CHECK 1 DID YOU PERFORM WHITE LEVEL CALIBRATION?

Use White Level Calibration to maintain the correct color balance of 
scanned images.

 Using the White Calibration Sheet

CHECK 2 DID YOU ADJUST THE BRIGHTNESS AND CONTRAST?

Depending on the image you scan, a white portion is not recognized as 
white because the scanner detects and scans even the small differences 
of the density between white and other colors.

Adjust the brightness and contrast.

• When you are using IS Scan Plus, use the online Help.

• When you are using a TWAIN-compatible graphics application program, 
see the User’s Manual for the application program.

Note
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Scanning Result Is Unsatisfactory

CHECK 3 DID YOU SCAN A MONOCHROME IMAGE USING THE COLOR OR 
GRAYSCALE SETTING?

If the Scanning Mode is set to Color or Grayscale, the scanner detects and 
scans even the grades of the density, and white may not be recognized as 
white.

When you scan a monochrome image, always set Black & White in the 
Scanning Mode so the scanner can scan using only two values between 
white and black.

For details on how to set Black & White in the Scanning Mode, use the 
online Help.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh
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Scanning Result Is Unsatisfactory

�  Parts of an Image Missing or Not Aligned Properly
CHECK 1 DID YOU PLACE AN IMAGE WITHIN THE PROPER SCANNING AREA?

Check that the image you wish to scan is placed in the proper scanning 
area.

CHECK 2 DID YOU SPECIFY THE SCANNING AREA CORRECTLY?

If the Paper Size setting is smaller than the size of the image you scan, 
parts of the image will be missing.

If you place the image outside the scanning area, parts of the image may 
not be aligned properly. Always check that the image is set within the 
proper scanning area.
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Scanning Result Is Unsatisfactory

�  Image Contains Unexpected Colors, or Is Too Light or Too Dark
The appearance of the scanned image is not what you expected, or the image is too light or 
too dark.

CHECK 1 IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 
COLOR?

Check the number of display colors as follows.

1 From the Start menu, select Settings, and then select Control Panel.

2 Double-click the Display icon, then click the Settings tab.

3 Check that Colors is set to High Color or True Color in the Colors box.

Check the Color Depth setting as follows.

1 From the Apple menu, select Control Panels.

2 Select Monitors & Sound.

3 Check that Thousands or Millions are set for Color Depth.

Windows

Macintosh
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Scanning Result Is Unsatisfactory

CHECK 2 IS COLOR MATCHING ENABLED?

The colors displayed on your display may not match the actual scanned 
colors.

Color Matching attains the best match between the colors displayed on 
your display and the actual colors in the scanned image.

You can enable Color Matching when the Scanning Mode is set for Color.

Check that Color Matching is enabled.

1 Click the Custom Setting button.

2 Make sure that Color Matching is enabled in the Custom Setting dialog 
box.

1 Select Settings from the Menu screen.

2 Make sure that Color Matching is enabled.

Windows

Macintosh
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Scanner Cannot Be Used With a TWAIN-compatible 
Application Program

Cannot Launch IS Scan From Within the TWAIN-compatible Graphics 
Application Program

Cannot Transfer to TWAIN-compatible Graphics Application Program
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Scanner Cannot Be Used With a TWAIN-compatible Application Program

�  Cannot Launch IS Scan From Within the TWAIN-compatible Graphics 
Application Program

CHECK DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 
YOU ARE USING SUPPORT THE LATEST 32-BIT TWAIN 
SPECIFICATIONS OR TWAIN SOURCE MANAGER (VERSION 1.5 OR 
LATER)?

When IS Scan is used as a TWAIN interface, you must use the latest 32-bit 
TWAIN-compatible graphics application program. See the User’s Manual 
for your application program.

When IS Scan is used as a TWAIN interface, you must use the graphics 
application program that supports the TWAIN Source Manager (Version 
1.5 or later). See the User’s Manual for your application program.

Windows

Macintosh
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Scanner Cannot Be Used With a TWAIN-compatible Application Program

�  Cannot Transfer to TWAIN-compatible Graphics Application Program
CHECK DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 

YOU ARE USING SUPPORT THE FILE FORMAT TYPE AND RESOLUTION 
OF THE IMAGE DATA?

Some TWAIN-compatible graphics application programs support specific 
file format types and resolution settings only. For example, the resolution 
settings of some OCR (optical character reader) application programs are 
limited to 300 or 400 dpi.

Check the file format types and resolution settings of the TWAIN-
compatible graphics application program first, and then scan and transfer 
the image again.
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Other Scanner Problems

Cannot Install Scanner Driver

Does Not Launch With Default Settings   

Improper Colors Displayed in the Dialog Box

Scanning Too Slow

Communication Error Occurs

Error Message Appears

Windows

Download from Www.Somanuals.com. All Manuals Search And Download.



348Scanner Problems

Other Scanner Problems

�  Cannot Install Scanner Driver
CHECK 1 DID YOU FOLLOW THE SCANNER DRIVER INSTALLATION 

INSTRUCTIONS?

 Installing the IS Scan Software

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the scanner driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the scanner software.

CHECK 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The scanner driver installation program may not execute successfully if it 
is run with other applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

CHECK 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION?  

If the installation splash screen did not start automatically when you 
loaded the CD-ROM, double-click the My Computer icon, then double-click 
the CD-ROM icon on the Windows desktop.

 Installing the IS Scan Software

Windows

Windows
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Other Scanner Problems

• The drive name (E: for example) varies according to how your system is 
set up.

CHECK 4 IS THERE A PROBLEM WITH THE CD-ROM?  

The Install Me First CD-ROM may be damaged. On the Windows desktop, 
double-click the My Computer icon then double-click the CD-ROM icon. If 
Windows cannot read the CD-ROM, call the Canon Customer Care Center 
for help. 

 Getting Help From Canon

Note

Windows

Download from Www.Somanuals.com. All Manuals Search And Download.



350Scanner Problems

Other Scanner Problems

�  Does Not Launch With Default Settings  

CHECK DID YOU LAUNCH IS SCAN FROM A TWAIN-COMPATIBLE GRAPHICS 
APPLICATION PROGRAM?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
graphics application program.

Depending on the TWAIN-compatible graphics application program, 
Previous Settings selected in the Standard Value box under the Custom 
Settings dialog box may be cleared, and standard settings characteristic of 
the TWAIN-compatible program you are using may be used when 
launching IS Scan.

To use the settings selected in the Custom Settings dialog box when 
launching IS Scan, follow these steps:

1 Select Save Settings File from the Settings menu.

2 The next time you launch IS Scan, select Open Settings File from the 
Settings menu.

Windows
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Other Scanner Problems

�  Improper Colors Displayed in the Dialog Box
CHECK IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 

COLOR?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
application program.

If the problem is not solved, change the number of display colors of your 
computer.

1 From the Start menu, select Settings, and then select Control Panel.

2 Double-click the Display icon, then click the Settings tab.

3 Check that the Colors setting is High Color or True Color in the Colors box.

Or, you may be able to solve the problem by minimizing the IS Scan 
window and then return to the original size.

Check the Color Depth setting.

1 From the Apple menu, select Control Panels.

2 Select Monitors & Sound.

3 Check that Thousands or Millions are set for Color Depth.

Windows

Macintosh
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Other Scanner Problems

�  Scanning Too Slow
Scanning is requiring an unusually long time.

CHECK ARE YOU USING A HIGHER RESOLUTION THAN REQUIRED?

In order to scan an image, your computer must be able to receive a large 
amount of data. Therefore, the scanning speed varies according to the 
performance of the computer.

To shorten the time required for scanning:

• Use the appropriate resolution setting. Make sure that the resolution is 
not set higher than you require.

• Use the prescanning capability.
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Other Scanner Problems

�  Communication Error Occurs
CHECK 1 DID YOU LAUNCH IS SCAN OR IS SCAN PLUS IMMEDIATELY AFTER IT 

WAS CLOSED?

Do not attempt to launch IS Scan or IS Scan Plus again immediately after 
it is closed. Wait for a few seconds and then launch again.

CHECK 2 IS THE PRINTER PLUGGED IN AND READY?

Check that the printer is plugged in and ready.

CHECK 3 ARE YOU USING THE USB INTERFACE RUNNING UNDER 
WINDOWS 98?

When using the USB interface running under Windows 98, a 
communication error may occur if the Hardware acceleration setting is 
Full. To solve the problem, follow these steps:

1 Double-click the System icon in the Control Panel for Windows.

2 When the System Properties window is displayed, click the Performance 
tab.

3 Click the Graphics button.

4 If Hardware acceleration is set to Full in the Advanced Graphics Settings 
dialog box, set to None.

Windows
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Other Scanner Problems

�  Error Message Appears
CHECK REFER TO THE ONLINE HELP.

From the main IS Scan screen, select Contents from the Help menu, or 
press F1.

Open the online Help. 

Windows

Macintosh
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